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Introduction 
 
Structure is a plug-in that adds the flexibility and power of a professional sampling workstation 
to your recording. Using proprietary technology and a musically intuitive design, Structure takes 
sampling within your audio software to a new level. 
 

System Requirements and Product Support 
 
For complete system requirements, compatibility information, and product registration, visit the 
AIR website: www.airmusictech.com. 
 

Installation 
 
Windows® 
 

1. Double-click the .exe installer file you downloaded. 

2. Follow the on-screen instructions.  

Note: Structure uses PACE copy protection, so it will install the PACE InterLok driver on your 
system if you do not already have it. As most audio software uses PACE copy protection, 
though, this is probably already installed on your system. 
 

Mac OS X 
 

1. Double-click the .pkg installer file you downloaded. 

2. Follow the on-screen instructions. 
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Overview 
 
Main Sections 
 
 

 
 
 
Patch List 
 
In the Patch list on the left side of Structure, all loaded patches are shown. You can create, 
select, mix, MIDI-assign, route, and group patches in the Patch list. Click a patch to select it for 
editing in the Parameter panel on the right. The handle on the left of the selected patch module 
is lit yellow. You can create, edit and save patches using the Patch menu on top of the Patch 
list. To learn more about the Patch list, see the Patch List section. 

Part List 

Page Tabs Parameter Panel 

Keyboard/Smart Knob section

Patch List 
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Part List 
 
The Part list shows the parts that are contained in a patch. A part can be a multisample, an 
insert effect, a Sub-patch, or a MIDI processor. The Part list contains all parts within the 
selected patch and reflects their grouping as well as audio and MIDI routing. You can create, 
select, move, and edit parts in the Part list. The vertical order of parts reflects the actual signal 
flow from top to bottom. This means that the audio output of a Sampler part is fed through any 
Audio FX parts below it. The resulting signal at the bottom of the Part list is sent to the Patch 
output. You can change the position of parts within the routing using drag and drop. See the 
Part List section for more information. 
 
The Different Types of Parts 

 

 
 
• MIDI Processor: Contains a MIDI processor with its settings, for example, a tuning scale. 

MIDI processors are placed before Sampler parts and change the way a Sampler part is 
played. 

• Sampler: Contains a multisample, its mapping information, metadata, and several sound 
shaping options, such as filters, envelopes and modulation. 

MIDI processor 

Sampler 

Sub-Patch 

Audio FX 
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• Sub-Patch: Groups multiple Sampler parts, insert effects, or MIDI effect parts within a 
patch for applying combined playback conditions within a patch. For example, in a patch 
that holds piano and string Sampler parts, you might want to route only the piano through 
a reverb effect. In this case, you would group the piano part and an effect part using a 
Sub-patch. Subpatches can be dragged to the Patch list to become patches. Patches can 
be dragged into the Part list of another patch to become a Sub-patch. See the Sub-Patch 
section for more information on using Sub-patches. 

• Audio FX: Contains an Insert effect with its parameter and output settings. 
 
Keyboard/Smart Knob Section 
 
The Keyboard section provides 88 
keys for playing Structure, six Smart 
knobs, and the Master output control. 
You can play and control Structure by 
clicking the keys, using MIDI input 
from a MIDI keyboard, or using MIDI 
data in an Instrument or MIDI track in 
Pro Tools. When Structure receives MIDI data, the keys reflect the MIDI note input. See 
Keyboard Section for more information. 
 
Smart Knobs: Each patch has six Smart knobs. Each Smart knob can be assigned to 
one or more Structure parameters within the patch. These linked parameters can then 
be remote controlled at the same time by one Smart knob. This can be useful for 
making complex sound design easy or to quickly adjust a patch to your session in 
terms of feel, timbre, enveloping, or any other sensible sound shaping parameter. 
 
Master (Output Volume): The Master control on the right adjusts Structure's Main 
volume for all outputs. 
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Parameter Panel 
 
The Parameter panel displays the different 
control pages selected by Page tabs. This 
could be the controls of a patch or a part 
on the Main page, the global effect slots 
on the Effects page, the Database, or the 
Browser. When a patch or part is selected, 
its parameters (such as playback settings 
or output assignments) are displayed in 
the Parameter panel and sorted into sub-
pages where necessary. 
 
 
 
 
 
Page Tabs 
 
Above the Parameter panel, you can select 
between five global Control pages covering 
parameters for all aspects of sampler programming. 
These Control pages are accessible by clicking their corresponding Page tab. 
 
 
To display the Output settings of a patch: 

1. Select a patch by clicking it. 

2. Access the Main page. 

3. Click on the Output sub-page tab in the 
Parameter panel. 
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Main (Main Page) 
 
After loading Structure, the Main page 
is selected by default. Coming from 
another page, click the Main tab to 
access the parameters for patches and 
parts. 
 
The Main page provides controls for all 
available playback parameters of 
patches and parts, such as transpose, 
modulation, and output assignments. 
These controls affect the patch or part 
which is currently selected. To learn 
more about the Main page, see the 
Main Page section. 
 
 
Effects (Global Send Effects) 
 
Click the Effects tab in the Parameter 
panel to display the Effects page. 
 
The Effects page provides four global 
effect slots with four inserts each. 
Audio from each patch, part, or zone 
can be sent individually to these on its 
Output sub-page. On the right, there is 
Structure's Main output also providing 
four inserts. To learn more about the 
Effects page, see the Effects Page 
section. 
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Database 
 
Click the Database tab in the Parameter 
panel to access the Database page. 
 
The Database provides tools for quick 
searching and browsing for files that have 
previously been registered in the database. 
The database reads out metadata including 
comments, manufacturer, and ranking for 
each file. Supported file types are Patch 
files, Part files, and samples (audio files). 
Three columns of freely selectable 
metadata fields enable you to find the files 
you need, by Style, Sound and 
Manufacturer. Within four clicks, all 
patches on your computer matching these criteria are displayed in the Result list. To learn 
more about the Database, see the Database Page section. 
 
Browser 
 
Click the Browser tab to access the 
Browser page. 
 
The Browser lets you search the local file 
system. Files like patches, parts, and 
samples can comfortably be loaded from 
here using "drag and drop." To learn more 
about the Browser, see the Browser Page 
section. 
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Setup Page 
 
Click the Setup tab to access the Setup 
page. 
 
The Setup page contains controls for 
adjusting Structure's basic configuration 
and behavior. There are settings for 
optimizing Structure's performance and 
integration with your audio software. To 
learn more about the Setup page, see the 
Setup Page section. 
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Structure File Types 
 
Three types of files can be saved with Structure: 
 
• Settings: Pro Tools Plug-In Settings Files, or "presets" save the current configuration of 

Structure with Patches and Parts (for more information about Pro Tools Plug-In Settings 
Files, see the Pro Tools Reference Guide). 

• Patch: A Patch is a single "instrument" that consists of parts. A patch can receive MIDI on 
a unique MIDI port and channel, and plays out through the selected audio output. 

• Part: A part can be a multisample, an insert effect, a Sub-patch, or a MIDI processor. 
 
Settings 
 
Using the Settings menu, you can save the complete state of the plug-in including all loaded 
patches, parts, their parameters, and routing. 
 
To save a settings file: 

1. Click the Settings menu and select Save Settings. 

2. In the following dialog, enter a name and location for the 
setting and click Save. 
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Patch 
 
You can save a single patch including its parts and 
all parameters in the Patch menu. 
 
To save a patch: 

1. Select the patch in the Patch list. 

2. Select Save Patch from the Patch menu. 

3. In the following dialog, enter a name and 
location for the patch and select one of the 
Export check boxes depending on how you 
want to export the patch. 

• Without Samples means that just the 
Patch file is saved without copying the 
used samples. 

• With Samples means that the used 
samples are copied into a folder named 
Samples next to the patch. The saved 
patch will point to the samples in this 
folder. 

• Monolithic means that a single Patch file 
is saved that contains all used samples. 

 



 

 12  
 

 
Part 
 
You can save a single part with all parameters in the Part menu. 
 
To save a part: 

1. Select the part in the Part list. 

2. Select Save Part from the Part menu. 

3. In the following dialog, enter a name and location 
and select one of the Export check boxes depending 
on how you want to export the part. 

• Without Samples means that just the Part file is saved without copying the used 
samples. 

• With Samples means that the used samples are copied into a folder named 
Samples next to the part. The saved part will point to the samples in this folder. 

• Monolithic means that a single Part file is saved which contains all used samples. 
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Importing Third-Party Sample Libraries 
 
You can import sampler programs, patches and libraries from other software samplers and 
manufacturers into Structure. The supported formats are SampleCell, SampleCell II, Kontakt, 
Kontakt2, Kontakt3, Gigasampler, and EXS 24. You can load these just like genuine Structure 
patches from the Browser or by using the Load dialog from the Patch menu. You can also 
load Gigasampler Patch format files.  
 
Important: 

• Please see the Structure Read Me document for possible known issues with the import of 
foreign sample formats. 

• Encrypted content from third-party vendors cannot be loaded in Structure. iLok-protected 
Structure Factory Libraries and other protected or encrypted sample libraries can only be 
saved as patches. They cannot be saved with samples or as monolithic files in Structure. 
For more information, see Loading and Saving Patches. 

• When importing Gigasampler Patch files, the sample files are copied to your local 
computer and a Structure Patch is created. You can specify the directory where Structure 
will copy the new files on the Setup page using Copy Samples to Local Drive Settings 
(Content > Copy Samples To Local Drive Options). 

• Please note that importing third-party sample libraries can be quite complex because of 
the many available versions of these formats and the different methods each vendor uses 
to make instruments play naturally (such as key switches, alternations, modulations, MIDI 
playback variations, and also different filters and effects). Consequently, a perfect 
reproduction of the original patch in Structure is not always possible. As a general rule, the 
simpler your original patch, the more precise the imported result in Structure. The larger 
and more complex your original file is, the more likely it is that you might need to invest 
some time tweaking the patch to get an exact sonic reproduction. 
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The Editor Window 
 
In the Editor window, you can display and modify individual samples within the Sampler parts in 
a patch. You can wave-edit and loop the contained samples, create and modify sample 
mappings, and adjust individual playback, filter, and amp settings per sample zone. The 
Treeview, Mapping, and Edit sections in the Editor window are designed to serve the different 
purposes of multi-sample editing as explained in the following. 
 

 
 

To learn more about the Editor window, see the Editor Window section. 
 
To access the Editor window for a patch, click the Edit 
button on a patch module. 

Treeview 
Section 

Mapping 
Section 

Edit 
Section 
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Treeview Section 
 
The Treeview section on the left lists the names of all Sampler 
parts of the patch and the names of all samples that are 
contained in these parts. Click a part or sample zone in the 
Treeview to select it for further editing in the Mapping and Edit 
section on the right. 
 
 
 
 
 
 
 
Mapping Section 
 
The Mapping section reflects the selected part's zones and their keyboard assignment as 
rectangular zones above the mini-keyboard. A zone represents a sample and holds all its 
relevant information like keyboard assignment and play parameters within Structure. Zones can 
be moved, modified, copied, or deleted in the Mapping section. The selection of zones in the 
Mapping section is synchronized to the Treeview, Wave, and Zone parameters within the Editor 
window. 
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Edit Section 
 
The Edit section holds four sub-
pages, each of which contains a 
useful editor or view. The subpages 
are explained in the following. 
 
 
 
 
 
 
 
 
 
To access the sub-pages, click the corresponding sub-
page tabs. 
 
• Zone (Zone Parameters): Provides controls for all available playback parameters of a 

Zone such as Transpose, Modulation, and Output assignment. The displayed parameter 
depends on which zone is currently selected.  

• Wave (Wave Editor): Displays the wave sample of the selected Zone in the Treeview or 
the Mapping section and provides tools to edit and loop these. The Wave Editor consists 
of a graphical waveform representation and a parameter and tool set above. 

• Browser: Provides controls for searching and displaying the local file system. Files like 
patches, parts, and samples can comfortably be loaded from here using drag and drop 
into the Patch or Part list. For more information, see the Browser Page section. 

• Database: Provides a powerful set of integrated tools for tracking, organizing and 
managing your Structure patches, parts, and samples. For more information, see the 
Database Page section. 
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MIDI Learn 
 
Structure lets you assign standard MIDI controllers ("MIDI Learn") to virtually any parameter so 
that you can control Structure from a MIDI controller in real-time. 
 
To assign a MIDI controller to a parameter (MIDI Learn): 

1. Right-click (Windows or Mac) or Control-click (Mac) a rotary 
control or fader.  

2. Click Learn MIDI CC, and move a control on your MIDI 
controller. The parameter is automatically assigned to that 
control. 

 
 
 
 
To un-assign a MIDI controller: 

1. Right-click (Windows or Mac) or 
Control-click (Mac) the rotary 
control or fader. 

2. Go to the Assigned to pop-up 
menu. 

3. Click the Name field and select 
Delete Assignment. 
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Adjusting Controls 
 
You can adjust all controls by using the computer mouse. Some controls are adjusted by a 
selecting a value from a pop-up menu or by activating a button. 
 
Parameter Ranges and Resolution 
 
Most controls have a range of 0–100%. Some controls are bipolar, meaning they support 
negative values and usually have a range of –100% to +100%. 
 
Using a Mouse 
 
You can adjust controls by dragging the control's slider or knob, or by moving 
over it with the cursor and scrolling up or down with the scroll wheel. Adjust rotary 
controls by dragging horizontally or vertically. Parameter values increase as you 
drag upward or to the right, and decrease as you drag downward or to the left. 
 
 
Activating Buttons 
 
Some controls are enabled or disabled using buttons. 
 
To enable a button, click the button. Click again to disable it. 
 
 
Zone Mode 
 
Some buttons on Part level do not only have an On or Off state but 
feature a third state, called Zone mode. This state is indicated by a 
black dot in the middle of the lit button. If Zone mode is activated, 
the state of this parameter is taken from each zone in the part 
(accessible in the Zone section of the Editor window). 
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Keyboard Shortcuts 
 
For finer adjustments, hold down Control (Windows) or Command (Mac) while moving the 
control.  
 
To return a control to its default value, Alt-click (Windows) or Option-click (Mac) the control. 
 
Displaying Values 
 
Parameter values of knobs and faders can be displayed in the Info display without editing them. 
 
To display the value of a control in the Info display, click the control without dragging it. 
 
Using Pop-up Menus 
 
Some controls have pop-up menus for selecting values. 
 
To choose a value from a pop-up menu: 

1. Click the parameter's selector. 

2. Select a value from the parameter's pop-up menu. 
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Scroll Wheel on Knobs, Faders, and Menus 
 
If your mouse has a scroll wheel, you can use it to adjust Structure parameters. 
 
To change a value with a scroll wheel: 

1. Move the cursor over a rotary knob or fader. 

2. Scroll the wheel up to increase values. Scroll the wheel down to decrease values. 
 
Adjusting Values by MIDI 
 
In the Editor window, you can adjust text box values by MIDI input. This can be helpful when 
defining, for example, key ranges. 
 
To adjust a value using MIDI input: 

1. Click into the text field. 

2. Play a note on your MIDI keyboard. 
 
 
 
See the MIDI Learn section for information on Structure's MIDI Learn functionality.  
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Quick Start 
 
This chapter helps you to explore Structure's basic concepts with a hands-on approach within 
Avid® Pro Tools®. You will touch the most important functions, understand the basic concepts 
and make the first guided steps to get Structure to sound.  
 
Inserting Structure On a Pro Tools Instrument Track 
 
To use the Structure plug-in, you have to insert it on a stereo or surround Instrument track 
(recommended), Auxiliary input, or Audio track. You can then play Structure using its on-screen 
keyboard, an external MIDI controller, or a track with MIDI data. 
 
Structure is the sole audio input source for any Instrument track, audio track, or Auxiliary input 
on which it is inserted. When Structure is inserted on an audio track, any audio clips on that 
track will not sound during playback. Additionally, the track input will effectively be muted during 
playback if Structure is inserted on the track. If Structure is inserted more than once in a single 
track, only the last Structure insert will produce sound. You can use Structure as an insert on 
more than one track at a time. 
 
To add a Structure plug-in to a track: 

1. Create a new stereo or surround Instrument 
track in Pro Tools. 

2. Click the track's Insert selector and choose 
Structure from the list. 

 
To remove the plug-in, click the Insert selector and 
choose No Insert. 
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Basic Operation 
 
Loading Structure 
 
1. Create a new stereo Instrument track in Pro 

Tools. 

2. Click the track's Insert selector and choose 
Structure from the list. 

 
 
 
 
 
 
 
Making Sound 
 

1. If you have a MIDI keyboard available and 
prefer to use it, connect it to Structure's MIDI 
input, and route it to Structure on MIDI channel 
1. If there is no MIDI keyboard available, you 
can play Structure by clicking the keyboard on 
screen, or using MIDI input from the Instrument 
track in Pro Tools. 

2. Play some notes on your MIDI keyboard. If all is 
well so far, you are hearing a sine wave signal 
from the default Sine Wave Patch at the top of 
the Patch list. 
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Loading a Patch 
 
1. Click the Browser tab in the Parameter panel to display the Browser page. 

2. Click your way through the folders to access the Structure QuickStart content folder. If you 
chose the suggested path during installation, it is located here, depending on your OS: 

• Windows: Program Files\Digidesign\Structure\Structure QuickStart 

• Mac OS X: /Applications/Digidesign/Structure/Structure QuickStart 

3. Drag the Patch named 01 Six String 
Guitar.patch onto the Sine Wave Patch to load it 
and replace the Sine Wave patch. A red frame 
around the patch when dragging indicates that you 
are replacing the existing patch with the new one. 
Wait until the Loading message in the display 
beneath the Parameter panel disappears. 

4. After loading, the multi-purpose display shows a 
short description of the Patch, and the Parameter 
panel above displays its Patch parameters. 

5. Play some notes and chords. Adjust the Patch 
volume using the horizontal fader on the Patch 
module in the Patch list. 

 
 
Finding Missing Samples 
 
If samples are not found, the concerned patches and 
parts are marked by a red exclamation point. 
 
To find the missing samples for a patch or part: 

1. In the Patch or Part menu, select Find Missing 
Samples. 

2. In the following dialog, navigate to the new sample location and click OK. 
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Exploring the Part List 
 
1. Click the small triangle on the lower left of the 

Patch module to show the Part list. 

2. As you can see here, the Patch consists of 
multiple parts: sampler parts (indicated by a 
keyboard symbol) and insert effect parts 
(indicated by an FX symbol). 

3. Select the sampler part to show its parameters in 
the Parameter panel. 

4. Click the EQ and Reverb effect parts to display their parameters in the Parameter panel. 
 
Editing Part Parameters 
 
1. Click 6 String Pick.part to bring up its parameters in the Parameter panel. 

2. Click the Filter sub-page tab to go to the part's filter settings. 

3. Set the Cutoff and Resonance controls at will. 

4. Click the Amp tab to go to the Amplifier 
subpage. Set the attack time to 200 ms by 
moving the upper left handle in the envelope. 

5. Use the attack fader (fader A) to set it back to 0. 

6. Now grab the top half of the Attack fader and set it to 20% for creating a velocity-sensitive 
attack behavior for the guitar part. 

 
Adding a Sampler Part 
 
1. Click the Browser Page tab to display the Browser in the Parameter panel. 

2. Drag the part 02 High String Guitar.part into the Part list below the 6 String Pick part. 
This adds a sampler part with high string guitar samples to the patch. 

3. Play some notes and chords; the six-string guitar has now become a twelve-string. 
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Adding an Effect Part 
 
1. Right-click the Part list below all parts. 

2. Select Add Part > Modulation > Phaser Stoned 
from the context menu. 

3. Play some notes and chords. Adjust the Effect 
controls in the Parameter panel. 

 
 
 
 
 
Saving the Patch 
 
1. To save the edited Patch, choose Save Patch from the Patch menu. 

2. In the file dialog, choose a name and destination for the Patch, and click OK. 
 
Adding Another Patch 
 
1. Click the Patch menu on the upper left of the Patch 

list and select Load Patch from the menu. 

2. Load Moving Synth Pad.patch from the QuickStart 
content in the dialog. Wait until the loading message 
disappears. Another Patch module is added under 
the guitar patch. 

3. The new Patch is assigned to MIDI channel 2. Assign 
it to MIDI channel 1 using the MIDI Input pop-up 
menu in the Patch module. 

4. Play a few notes to hear guitar and synth pad play 
together. In the next steps we will adjust the synth 
pad to make up a nice combination with the guitar using Smart Knobs. 
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Using Smart Knobs 
 
Every Patch has six Smart Knob assignments which are (in the factory content) 
pre-assigned to useful parameters. You can use them to easily adjust a patch to fit 
your session.  
 
1. Select the synth patch to display its Smart Knob assignments in the Keyboard 

section. 

2. Set the Smart Knob for Cutoff to 30%. 

3. Set the Smart Knob for Attack to 65%. 

4. Set the Smart Knobs for Phaser and Delay to 30%. 

5. Set the Smart Knob for Release to 75%. 
 
Modulating Amplitude by LFO 
 
1. Select the synth patch and click the 

Mod subpage tab in the Parameter 
panel. 

2. Play a chord or note and move your 
MIDI keyboards Mod wheel up. You 
will hear a gating effect on the synth 
pad. This effect is created by LFO 1 
which modulates the patch amplitude. 
The modulation depth of LFO 1 is hard-wired to the Mod wheel. 

3. Drag the handles of the LFO waveform to adjust the gating effect. 
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Using Global Send Effects 
 
1. Select the guitar patch, and go to its Output 

sub-page in the Parameter panel. 

2. Move the FX Send 1 fader all the way to the 
right to feed the Patch into the first Effect slot. 

3. Click the Effects tab to show the Effects page 

in the Parameter panel. 

4. Click the first insert on the first Effect slot and 
select a reverb preset. 

5. Click the Effect insert to adjust the effect 
parameters in the Parameter panel. Click Back 
when done. 



 

 28  
 

 
Using Key Switches 
 
Key Switches are special MIDI notes or keys that are assigned to switch control values instead 
of triggering notes. For example, they can switch between different Smart Knob settings for a 
Patch or mute certain parts within a patch. Nearly every control in Structure can be assigned to 
a Key switch. 
 
1. Load the Patch 04 Electronic Drum Kit.patch, and play with it on your keyboard. 

2. The different Effect parts in this specific Patch are not audible initially. Their Mix 
parameters and Smart Knobs are assigned to key switches so you can mix them in by just 
clicking or playing a Key Switch. All available Key Switches appear blue on the screen 
keyboard. The currently activated Key switch is green. After activating a Key Switch, a 
short description is shown in the multi-purpose display. A Key switch does not trigger 
samples that are mapped in the corresponding key range. 

3. Click the second Key Switch C#0, or play the 
corresponding key to add dirt to the kit's sound. 

4. Try out the other Key Switches. 

5. The synth pad patch has Key Switches too. Check them 
out! 
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Working with REX Files 
 
Structure is capable of directly importing REX files. When you load a REX file in Structure as a 
patch it is automatically split up in two parts: a sampler part which holds the slices of audio and 
a MIDI part which plays back these slices in the correct tempo and order. 
 
1. Drag the REX file 05 4 On The Floor Loop.rx2 from the QuickStart folder into the Patch 

list. Structure automatically creates a new Patch module with two parts: a Rex Player and 
a sampler part. 

2. Assign the patch to MIDI channel 1. 

3. Solo the patch. 

4. Play notes between C0 and B0 to trigger single slices of the loop. 

5. Hold down a note from C1 upwards to trigger the REX loop at different pitches. The loop 
tempo automatically matches your session tempo. 

 
For more information about Rex Player controls, see the Rex Player section. 
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Using Viewgroups 
 
In complex setups with lots of patches it can be useful to organize patches in viewgroups for a 
better overview. Viewgroups do not affect the playback but only the displaying of Patches. Let's 
put the guitar and the synth patch into one viewgroup called Keys and the drum and the loop 
patch in a viewgroup called Drums. 
 
1. Click on the View menu on top of the Patch list. 

2. Select View 1. 

3. Double-click View 1 and type Keys to rename it. 

4. Accordingly, select View 2 and rename it to 
Drums. 

5. Select View All to show all patches. 

6. Right-click the 04 Electronic Drum Kit patch to 
open the Patch menu. 

7. Select Show In View > Drums. 

Now, when you select Keys from the menu, the Patch list shows the guitar and synth 
patches. When you select Drums, it shows the other.  

Select All again to see all Patches in the Patch list. 
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Exploring the Editor Window 
 
1. Select Remove All Patches from the Patch menu. 

2. Load 04 Electronic Drum Kit.patch, and wait until the loading message disappears. 

3. Click the Edit button on the upper right of the Patch module. 

4. The Editor Window is resizable. Drag the handle on the lower right to resize it to suit your 
screen space. 

5. The Treeview on the left shows the eleven parts which make up this patch. Clicking on the 
plus (+) symbol next to a part reveals a list of its sample zones. 

6. Play a few keys or click some keys on the screen keyboard. You can see that this selects 
Zones in the Mapping section. The corresponding views of the selected zones are shown 
in the Treeview and in the Wave editor. 

 
Zooming the Mapping Section 
 
1. To zoom into the Mapping section, click the right Zoom button on the 

upper left of the Mapping section. 

2. Double-click any Zone to zoom and center it. Double-click again to 
zoom out. 

3. Click the Zoom Selection button to fully zoom into the selected Zones. 
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Moving Sample Zones 
 
1. Select the FX part in the treeview. Its sample 

zones are selected in the Mapping section. 

2. Drag the zone frames in the Mapping section to 
change their velocity and key mapping. 

3. Drag sample zones to move them around in the 
Mapping section. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Undoing the Last Step 
 
Select Undo from the Edit menu in the Treeview section to revert the last editing step. 
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Setting Sample Start and End Points 
 
On the top right of the Editor window, the Wave editor shows the waveform of the currently 
selected Zone. Here you find the same zooming tools as in the Mapping section. 
 
1. Select a Zone to display its sample waveform, and drag horizontally into the waveform to 

make a selection. 

2. Click the Zoom Selection button to fully zoom into the selected area. 

3. Right-click (Windows) or Control-click (Mac OS X) into the 
selection to show the context menu. Choose Set Sample to 
set the sample start and end points to your selection. 

4. Select the whole waveform and choose Set Sample again to 
bring the sample back to its initial state. 

 
 
 
 
 
 
Using Zone Parameters 
 
1. Click the Zone tab to bring up the sub-page for Zone parameters. Zone parameters are 

basically the same as Part parameters but are applied individually per zone. You can 
apply Zone parameters to multiple selected Zones at a time. 

2. Go to the Treeview and select the folder FX which holds all three zones of the upper 
octaves. All Zones must be selected. 

3. Set the Octave control in the Zone parameters to –1. All 
selected zones are now tuned down by one octave.  
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Playing, Mixing, and Recording Structure: Pro Tools 
 
Whether you are using a single instance of Structure or multiple instances, you can take 
advantage of the vast capabilities of Pro Tools as a powerful MIDI sequencing, recording, 
editing, and mixing environment. 
 
Bus-Recording Structure 
 
One of the first and easiest things you might want to 
do is record your performance using a single 
instance of Structure. 
 
To bus record Structure in Pro Tools: 

1. If you haven't already done so, insert Structure 
on a stereo Instrument track and set it up for 
performance. 

2. Create a new stereo audio track. 

3. Assign the audio Output of the Instrument 
track on which Structure is inserted to a bus 
(such as Bus 7–8). 

4. Select the same bus (such as Bus 7–8) as the 
Input of the stereo audio track for recording 
(see image). 
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Routing Multiple MIDI Tracks to Different Parts in Structure 
 
Each Part in a single instance of Structure can receive MIDI data from Pro Tools on unique 
virtual MIDI ports and channels. In this way you can use a single instance of Structure as an 
entire band or orchestra, with each Part played by separate Pro Tools MIDI tracks. 
 
To route Pro Tools MIDI tracks to Parts in Structure: 

1. If you haven't already done so, insert Structure on a 
stereo Instrument track and set it up for performance 
with two or more Parts. 

2. In the Part list in Structure, assign each Part to a 
unique MIDI Port and channel input. 

3. In Pro Tools, create the corresponding number of 
MIDI tracks. 

4. Assign each MIDI track Output to a unique Structure 
Part MIDI Input Port and Channel. 
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Routing Structure Audio Outs to Multiple Pro Tools Tracks 
 
A more sophisticated way to work with Structure than simple bus-recording is to assign different 
Parts in Structure to different Audio Outs. You can then route the different Outputs from Parts in 
Structure to the Inputs of multiple tracks in your Pro Tools session for multitrack mixing, 
processing, and recording. 
 
To assign Structure Parts to separate Outputs and route to Pro Tools tracks: 
1. In the Part list in Structure, assign each Part to 

a separate Audio Out. 
2. In your Pro Tools session, create enough new 

stereo Auxiliary Input (for monitoring and 
mixing) or audio tracks (for recording and 
mixing) for each of the Audio Outs used by the 
Parts in Structure. 
Note: The Audio Outs from Structure are 
stereo, so if you want to mix each Part to a 
mono track in Pro Tools, assign pairs of Parts 
to the same Audio Out (for example, assign 
both the first and second part to Out 4). Then 
for each pair, pan one Part hard left and the 
other hard right. You can then select the left or 
right channel of a single Structure Out as the 
Input of a mono track in Pro Tools. 

3. Select the corresponding Structure 
Audio Out from each Pro Tools 
track Input selector. 
You can now record, mix, and 
process multiple Structure Outs 
independently in your Pro Tools 
Session. 

Important: For more information about mixing and recording instrument plug-ins in Pro Tools, 
see the Pro Tools Reference Guide. 
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Using Structure on Multichannel (Greater-Than-Stereo) Tracks  
 
Important: For Pro Tools HD and Pro Tools with Complete Production Toolkit Only. 
 
While most instrument plug-ins are only mono or stereo (even those that provide multiple audio 
outputs), Structure can be inserted on, or bussed to, multichannel tracks up to 8 channels in 
width. While some factory patches in Structure are specifically designed to play back on 
multichannel tracks, not every patch in Structure will play through all channels of a multichannel 
track. For example, a stereo patch played back on an LCR track will only play through channels 
L and R, and not C. However, you can add a surround panner FX Patch to parts in Structure to 
effectively make any patch play to any of the common surround formats (such as LCR, Quad, 
and 5.1). 
 
To use Structure in surround: 

1. In your Pro Tools session, create 
a new multichannel instrument 
track (such as 5.1). 

2. Make sure the track Output is 
assigned to a multichannel 
output path for monitoring. 

3. Insert Structure on the track. 

4. In Structure, select a 5.1 patch 
and play Structure. 
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To pan a stereo (or mono) Sampler patch to surround in Structure: 

1. In the Part list, reveal the Patch 
list for the Part you want to pan 
to surround. 

2. From the Patch menu, select 
Add Part > Tools and select 
the type of surround panning 
you want. 
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Controls 
 
Keyboard Section 
 

 
 
 
 
The Keyboard section provides 88 keys for playing Structure, six Smart knobs, and a context 
sensitive Info display, as well as the Master volume control for the whole plug-in. You can play 
and control Structure by clicking the keys, using MIDI input from a MIDI keyboard, or using 
MIDI data in an Instrument or MIDI track in Pro Tools. When Structure receives MIDI data, the 
keys reflect the MIDI note input. 

Keyboard

Smart 
Knobs 

Master Volume 
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Smart Knobs 
 
The Smart knobs are special controls which can be assigned to one or more 
Structure parameters in the currently selected patch. These parameters can then 
be remote controlled at the same time by moving the Smart knob. This comes in 
handy for making complex sound design easy or to quickly adjust a patch to suit 
your session in terms of feel, timbre, enveloping, or any other sensible sound 
shaping parameter. In Structure's factory content, each patch has Smart knobs 
pre-assigned to important parameters. The Smart knob can be named in the field above each 
knob. 
 
To assign a parameter to a Smart knob: 

1. Right-click (Windows or Mac) or Control-click 
(Mac) a control. 

2. Select a Smart knob from the Assign Smart 
Knob pop-up menu. 

 
 
 
 
 
 
 
To remove a Smart knob assignment: 

1. Right-click (Windows or Mac) or 
Control-click (Mac) the control. 

2. In the Assigned to pop-up menu, 
click the control name field and 
select Delete Assignment. 
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Key Switches 
 
Key Switches are special MIDI notes or keys that are assigned 
to controls and act as a switch. For example, they can switch 
between different Smart Knob settings for a patch or mute and 
solo parts within a patch. 
 
 
 
 
 
To assign a parameter to a Key switch: 

1. Right-click (Windows or Mac) or Control-click (Mac) a 
control. 

2. Select a Key switch from the Assign Key switch pop-up 
menu. 

 
 

 

To remove a Key switch assignment: 

1. Right-click (Windows or Mac) 
or Control-click (Mac) the 
control. 

2. In the Assigned to pop-up 
menu, click the control name 
field and select Delete 
Assignment. 

 
 
Tip: You can edit the Key switch and Smart knob assignments in detail on the Control 
subpage of the patch. If you want to learn more, see Using the Control Line. 
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Master (Output Volume) 
 
The Master control adjusts Structure volume of all Structure outputs to Pro Tools. 
All patches are mixed down to the Main output by default, and then output to the 
Instrument or Auxiliary Input track on which Structure is inserted. 
 
 
 
Info Display 
 
The Info display above the Keyboard 
section is a context-sensitive text 
display. When you load something 
into Structure, it displays a progress 
bar. When loading a commented 
patch, it displays the Patch comment. 
When editing controls, it displays 
parameter name and value. 
 
To display the control's current 
value, click the control without 
moving the mouse. 
 
To edit the patch comment: 

1. Select a patch. 

2. Double-click into the Info display. 

3. Type in your comment. 

4. Press Enter. 
 
Note: The Display does not show parameter values of incoming automation, as multiple 
parameters in different patches could be changing simultaneously. Only values edited using the 
mouse are shown. 
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Patch List 
 
In the Patch list on the left side of 
Structure, you can create, select, mix, 
MIDI-assign, route, and group patches. A 
patch holds a virtually unlimited number 
of parts (a part can be a multisample, an 
insert effect, or a MIDI module) with a 
defined audio and MIDI routing.  
 
Click a Patch module to select it for 
editing in the Parameter panel. The 
handle on the left of the selected patch is 
lit. When a patch is selected all of its 
parameters are displayed in the 
Parameter panel on the right and 
assorted into subpages. 
 
You can create, edit and save patches 
using the Patch menu on top of the Patch 
list. 
 

Patch Menu 

Patch Module 

Part List 
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Patch Module Controls 
 
 

 
 
 
Quick Browse Menu for Favorite Folders: Gives quick access to the factory content folders 
and folders that have been added to the favorites. Click the double arrow to bring up the 
favorite folders menu from which you can directly select Structure Patches. See the Browser 
Page section for more information on how to add a folder to your favorites. 

Mute Button: Mutes the patch. 

Solo Button: Solos the patch. 

Volume Fader: Adjusts the Patch volume. 

Panorama Fader: Adjusts the patch's position in the stereo panorama. 

MIDI Channel Selector: Selects the Port (A–H) and channel (1–16) on which the patch 
receives MIDI data. 

Audio Out Selector: Selects the patch's individual audio output (Out 1–32). The Audio Out 
paths for Structure are stereo. 

Edit Button: Brings up the Editor window of the Patch in which you can edit the mapping, 
wave, and zone settings of its sampler parts. To learn more about the Editor window please see 
the Editor Window section. 

Quick 
Browse Menu 

Expand 
Part List 

Panorama 
Fader 
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Patch Menu 
 
Tip: You can also Right-click on a Patch to access the Patch menu. 
 
Load Patch: The Load Patch command brings up a dialog for selecting a patch that will be 
added below the currently selected patch in the Patch list. 

Save Patch: The Save Patch command brings up a dialog for saving the selected patch to 
disk. See the Save Dialog Controls section for more information. 

Add Patch: The Add Patch submenu lets you add a new empty patch to the end of the Patch 
list. Like the Quick Browse Menu, it provides access to your Favorite folders for loading 
patches. 

Duplicate Patch: The Duplicate Patch command adds an exact copy of the selected patch 
below it in the Patch list. 

Remove Patch: The Remove Patch command unloads the selected patch, removing it from the 
Patch list. 

Remove All Patches: The Remove All Patches command clears the Patch list of all loaded 
patches. Click OK in the prompted security dialog if you really want to clear the whole Patch list. 

Cut Patch: The Cut Patch command copies the selected patch to the clipboard and removes it 
from the Patch list. 

Copy Patch: The Copy Patch command copies the selected patch to the clipboard. 

Paste Patch: The Paste Patch command inserts the copied patch on the clipboard at the end 
of the Patch list. 

Paste Patch Parameter: The Paste Patch Parameter command inserts only the parameter 
settings of the copied patch to the selected patch. 

Show in View: The Show in View command assigns the patch to one of the eight viewgroups. 
If the patch is assigned to a viewgroup, it appears only in the Patch list when the corresponding 
viewgroup is activated. See the Viewgroups section for more information. 
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Automation Channel: Structure provides 16 automation channels, each of which provides 
automation for the most important Patch parameters like level, solo, mute, and Smart knobs. 
(Structure has so many available parameters that it is not possible to allow Pro Tools 
automation for all of them.)  

Each automation channel (A, B, C, D, …) can be assigned to one patch. In the Pro Tools plug-
in automation dialog the automatable parameters for each channel are distinguishable by the 
corresponding letter. For example, A Level for the Volume fader of the patch assigned to 
automation channel A. Automation channels are assigned subsequent to the patches in the 
Patch list by default, but the assignment can be changed using the Automation Channel 
submenu. 

To assign a patch to an Automation channel: 

1. Select a patch. 

2. Go to Patch > Automation, and select an 
Automation channel from the menu. 

 
Edit Metadata: If you use the integrated Database, you can use the Edit Metadata dialog to 
edit a file's metadata tags. Metadata tags provide information which is used for improved 
searching in the Database. See the Database Page section for more information. 
 
Find Missing Samples: If a loaded patch does not find its samples, you can use the Find 
Missing Samples dialog to point Structure to the location of the samples. For more information, 
see Finding Missing Samples. 
 
Unload Unused Samples: The Unload Unused Samples command lets you remove all 
samples that are not used in the current part, patch, or Pro Tools session from your computer's 
RAM. You can use this function to lower Structure's RAM consumption. For more information, 
see Removing Redundant Samples from RAM. 
 
Reload Unused Samples: The Reload Unused Samples loads previously removed samples 
back into RAM, either for the selected patch, all patches, or the whole Session. 
 



 

 47  
 

 
Copy Samples to Local Drive: If you have loaded samples from removable media like a CD, 
DVD, or over the network into Structure, a yellow exclamation mark symbol indicates the 
affected patches and parts. Use the Copy Samples to Local Drive function to transfer the 
loaded samples to your computer's disk. On the Setup page, you can define a folder to which 
Structure will copy these files. After transferring the samples Structure can load the concerned 
patches and parts without requiring the source CD, DVD, or network folder. See Copy 
Samples to Local Drive Options for more information. 

• Selected Patch copies the samples of the selected patch to disk. 

• All Patches copies the samples of all patches of the Structure instance to disk. 

• Session copies the samples of all patches of all Structure instances in your session 
to disk. 

 
Loading and Saving Patches 
 
You can load and save patches using the Patch menu. 
 
To load a patch from the browser: 

1. Go to the Browser page. 

2. Navigate to a folder. 

3. Drag the patch file into the Patch list. 
 
To save a patch: 

1. Go to the Patch menu and click Save Patch As. 

2. In the following file dialog, name the patch and select a location. 

3. Click OK. 



 

 48  
 

 
Save Dialog Controls 
 
Export Without Samples: Saves the patch 
without creating a new copy of the samples. 

Export With Samples: Saves the patch file 
and a copy of all used samples. The 
exported samples are placed into a folder 
called Samples next to the saved Patch file. 

Export Monolithic: Saves a monolithic 
Patch file that contains all used samples. 

Trim Audio: Removes all audio data 
before the sample start and after the 
sample end marker from the exported 
samples. 

Format: Selects a file format the exported 
samples are saved in (AIFF or WAVE). 

Sample Rate:  Selects a sample rate for 
the sample export. The Zone setting uses 
the same sample rate as the loaded 
sample. 

Bit Depth: Selects a bit depth for the 
sample export. 

Important: The iLok-protected Structure 
Factory Libraries and other protected or encrypted sample libraries can only be saved as 
patches not with samples or monolithic. 
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Viewgroups 
 
In complex setups with lots of patches, it can be helpful to organize patches in viewgroups for a 
better overview and patch handling. When a viewgroup is selected, only its assigned patches 
are shown in the Patch list. Structure provides eight renamable viewgroups. 
 
Note: Viewgroups do not affect the playback of Patches. They only affect the display of 
Patches. 
 
To assign a patch to a viewgroup: 

1. Select a patch. 

2. In the Patch menu, go to Show In View, and select a viewgroup from the submenu. 
 
To select a viewgroup, click into the Name field and 
select a viewgroup. 
 
To rename a viewgroup, double-click into the Name 
field and type in a name for the selected viewgroup. 



 

 50  
 

 
Removing Redundant Samples from RAM 
 
The Unload Unused Samples command lets you remove samples that are not used in the 
current part, patch, or Pro Tools session from your computer's RAM. To find out which samples 
can be removed, Structure needs to analyze your session as described in the following 
procedure.  
 
To remove the unused samples from RAM: 

1. Go to the Patch menu and select one of the following from the Unload Unused Samples 
submenu: 

• Patch: Removes unused samples only for the selected patch. 

• All Patches: Removes unused samples for all patches 

• Session: Removes unused samples for all instances of Structure in your session. 

2. The Info display will show a message asking to start playback of the session for analysis. 
Start Pro Tools and play back the whole session. 

3. After playback has been stopped click Apply in the Info display to remove all unused 
samples from RAM, or click Cancel if you want to keep the samples in RAM. 

 

 
 

Reload Unused Samples 
 
The Reload Unused Samples command loads previously removed samples back into RAM, 
either for the selected patch, all patches, or all Structure instances in the whole Session. 
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Part List 
 
The Part list shows the parts that are contained in a patch. A part can be a multisample, an 
insert effect, a Sub-patch, or a MIDI processor. The Part list contains all parts within the 
selected patch and reflects their grouping as well as audio and MIDI routing. You can create, 
select, move, and edit parts in the Part list. 
 
To expand and collapse a patch's Part list, click 
the small triangle on the left of the patch. 
 
The vertical order of parts reflects the actual signal 
flow from top to bottom. This means that the audio 
output of a sampler part is fed through any Audio FX 
parts below it. The resulting signal at the bottom of 
the Part list is sent to the Patch output. You can 
change the position of parts within the routing using 
"drag and drop." 
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The Different Types of Parts 
 

 
 
MIDI Processor: Contains a MIDI processor with its settings (such as a tuning scale). MIDI 
processors are placed before Sampler parts and change the way a Sampler part is played.  

Sampler: Contains a multisample, its mapping information, metadata, and several sound 
shaping options (such as filters, envelopes, and modulation). 

Sub-Patch: Groups multiple Sampler parts, insert effects, or MIDI effect parts within a patch for 
applying combined playback conditions within a patch. For example, in a patch that holds piano 
and string Sampler parts, you might want to route only the piano through a reverb effect. In this 
case, you would group the piano part and an effect part using a Sub-patch. Subpatches can be 
dragged to the Patch list to become patches. Patches can be dragged into the Part list of 
another patch to become a Sub-patch. For more information on using Sub-patches, see the 
Sub-Patch section. 

Audio FX: Contains an Insert effect with its parameter and output settings. Select an Audio FX 
Part in the Part list to show the Audio Effect controls in the Main page.  

MIDI processor 

Sampler 

Sub-Patch 

Audio FX 
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Part Parameters 
 
Mute Button: Mutes/bypasses the part. 

Solo Button: Solos the part. 
 
Part Menu 
 
Tip: You can also right-click on a Part to access the Part menu. 
 
Load Part: The Load Part command brings up a file dialog for selecting a part that will be 
added below the last part in the Part list. 

Save Part: The Save Part command brings up a dialog for saving the selected part to disk. 

Add Part: The Add Part submenu lets you add a new part (Sampler, Sub-Patch, FX, or MIDI) 
to the selected patch. 

Remove Part: The Remove Part command removes the selected part from the Part list. 

Duplicate Part: The Duplicate Part command adds an exact copy of the selected part at the 
end of the Part list. 

Cut Part: The Cut Part command copies the selected part to the clipboard and removes it from 
the Part list. 

Copy Part: The Copy Part command copies the selected Part to the clipboard. 

Paste Part: The Paste Part command inserts the copied Part from the clipboard at the end of 
the Part list. 

Paste Part Parameters: The Paste Part Parameters command inserts only the parameter 
settings of the copied part to the selected part. This function can only be used with the same 
types of parts. Zones and Zone parameters are not pasted. 
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Find Missing Samples: If a loaded part does not find its samples, you can use the Find 
Missing Samples file dialog to point Structure to the location of the samples. For more 
information, see the Finding Missing Samples section. 

Replace Samples: The Replace Samples function brings up a dialog to locate samples to 
replace the ones currently used in the part. The new samples must be named exactly as the 
ones to be replaced. You would commonly use this function to replace samples in a part with 
newer or processed versions.  

Move Part Up: The Move Part Up command moves the selected part one level up in the 
routing. 

Move Part Down: The Move Part Down command moves the selected part one level down in 
the routing. 
 
Loading and Saving Parts 
 
You can load and save parts using the Part menu in the Patch list. 
 
To load a part from the Browser: 

1. Go to the Browser page. 

2. Navigate to a folder. 

3. Drag the part file into the Part list. 
 
To save a part: 

1. Go to the Part menu and click Save Part As. 

2. Set the Save Dialog controls (see below), name the part, and select a location. 

3. Click OK. 
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Save Dialog Controls 
 
Export Without Samples: Saves the part 
without creating a new copy of the samples. 

Export With Samples: Saves the part file 
and a copy of all used samples. The 
exported samples are placed into a folder 
called Samples next to the saved Part file. 

Export Monolithic: Saves a monolithic 
Part file that contains all used samples. 

Trim Audio: Removes all audio data 
before the sample start and after the 
sample end marker from the exported 
samples. 

Format: Selects a file format the exported 
samples are saved in (AIFF or WAVE). 

Sample Rate: Selects a sample rate for the 
sample export. 

Bit Depth: Selects a bit depth for the 
sample export. 
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Finding Missing Samples 
 
If a loaded patch or part does not find its samples because folders have been renamed or 
moved to another location, you can use the Find Missing Samples file dialog to point Structure 
to the new location of the samples. Patches and parts which are missing samples are indicated 
by a red exclamation mark symbol. 
 
To find the missing samples for a patch or part: 

1. Right-click (Windows or Mac) or Control-click 
(Mac) the concerned patch or part, and select 
Find Missing Samples from the menu. 

2. In the following dialog navigate to the new 
sample location and click OK. 

 
Full Recursive Search: Search for missing samples in the specified folder and all its 
subfolders. 
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Sub-Patch 
 
A Sub-patch is a special type of part. 
You can use a Sub-patch to group any 
combination of parts, and to control 
how they are played. 
 
Common uses for a Sub-patch: 

• Grouping Sampler and FX parts. 
For example, FX parts in a Sub-
patch only affect Sampler parts 
within the same Sub-patch.  

• Setting playback conditions for 
parts. For example, setting a 
Sampler part to only play when 
keys are released (on MIDI note-
off messages). 

 
Sub-Patch Controls 
 
Octave: Transposes the incoming MIDI notes for the Sub-patch in octave steps. 

Semi: Transposes the incoming MIDI notes for the Sub-patch in semitone steps. 

Fine: Tune tunes the Sub-patch up and down by cents. 

Pitch Bend: Activates the reception of MIDI Pitch Bend for the Sub-patch. 
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Condition: Selects up to three play conditions for the Sub-patch, selected from the following: 

• Key: Key number of incoming note. 

• Velocity: Velocity of incoming note. 

• Mod wheel: Current CC1 value. 

• Sustain Pedal: Current CC64 value. 

• Soft Pedal: Current CC67 value. 

• Playing Speed: Time since last note-on. 

• Legato Interval: Distance on keyboard from last key played. 

• Held Notes: Number of keys currently held. 

• Random Value: Different random value for each note played. 

• Smart Knob: Positions of Smart Knobs 1–6. 

• Key Switch: Last Key switch pressed. 
 
Range: Adjusts the range for the selected condition. 
 
Trigger On: Sets when notes will be triggered in all Sampler parts contained the Sub-patch: 

• Note On: Triggers the Sub-patch when a note is received. 

• Note Off: Triggers the Sub-patch when a note is released, including notes released 
by lifting the sustain pedal. 

• Key Up: Triggers the Sub-patch when a note is released, even if the sustain pedal is 
held. 

• Condition A True: Triggers the Sub-patch when the value of the first condition 
enters the specified range. (For example, useful for piano sustain resonance that 
starts when the sustain pedal is pressed). 

 
Velocity Source: Selects wether the velocity of notes sent to contained parts is taken from the 
note-on velocity or the note-off velocity of the incoming note, when Trigger On is set to Note Off 
or Key Up. 
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Level Decay: Reduces the amplitude of Note Off and Key Up triggers depending on how long 
the note has been held. 
 
Velocity Decay: Reduces the velocity of Note Off and Key Up triggers depending on how long 
the note has been held. Velocity may then have an effect on amplitude as programmed in the 
Sampler part, but may also used for sample selection. 
 
Decay Keytrack: Makes Level Decay and Velocity Decay faster for higher notes on the 
keyboard. Emulates the behavior of pianos, guitars, and other similar instruments: 

• 0: No keytracking 

• 100: Each octave decays twice as fast as the octave below. 
 
 
To add a Sub-patch to the Part-list, right-click (Windows or Mac) or Control-click (Mac) into 
the Part list, and choose Add Part > Sub-Patch from the pop-up menu. 
 
To group a part in a Sub-patch: 

1. Drag the part under the Sub-patch until a red 
line appears. 

2. Release the mouse button. Parts grouped in a 
Sub-patch appear indented in the Part list. 
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Sub-Patch Output Page 
 
On the Output Sub-page, you can assign the Sub-patch to individual outputs, and adjust its 
output level and send amount to each of the four Send Effect slots on the Effects page. 
 
FX Send On: Activates the Effect Send for the Sub-patch. 

FX Send Level: Adjusts the level sent from the Sub-patch to the Effect send. 

Pre: Sets the Effect send to pre-fader routing. When activated the Send level is only controlled 
by the Send fader, not the patch level or output level faders. 

Level Trim: Adjusts the Sub-patch's output level.  

Output Bus: Selects an individual Output bus for the Sub-patch. If an output is selected here, 
audio from the Sub-patch will not pass into the patch containing it, and will not be affected by 
the patch's output settings.  
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Main Page 
 
 
 

 
 

After inserting Structure, the Main page is selected by default. Coming from another page, click 
the Main tab to access the parameters for patches and parts. The Main page provides easy 
access to all useful Patch and Part parameters like transposition, filter, and output on sub-
pages. If a patch or part is selected, Structure switches automatically to the Main page. 
 
To show the Play parameters of a patch: 

1. Go to the Main page. 

2. Click a patch in the Patch list. The selected patch appears blue. 

Page Tabs

Patch Name Sub-Page Tabs 
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To show the play parameters of a part, click a part in the Part list. The selected part is shown 
with a light blue background. 
 
To access the different Parameter sub-pages for patches 
and parts, click the sub-page tabs in the Parameter panel. 
 
Patch Parameter Sub-Pages 
 
Play Sub-Page 
 
Octave: Transposes the incoming MIDI notes for the patch in octave steps. 

Semi: Transposes the incoming MIDI notes for the patch in semitone steps. 

Fine Tune: Tunes the patch up and down in cents. 

Pitch Bend Up: Sets the upward pitch bend range for the patch in semitones. 

Pitch Bend Down: Sets the downward pitch bend range for the patch in semitones. 

Max Polyphony: Sets the maximum number of voices available for the patch. 

Note: Each sample zone in each Sampler part triggered by a note-on uses one voice. For 
example, a patch containing two Sampler parts with one zone each per key will use two 
voices for each held note. 

Priority: Sets the voice stealing priority for the patch. Voices in patches set to low priority will 
be stolen first.  

Key Range: Sets the key range in which the patch plays. You can define the upper and lower 
borders and a transition. 

Vel (Velocity) Range: Sets the velocity range in which the patch plays. You can define the 
upper and lower velocity limits and a transition. 
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Control Sub-Page 
 
On the Control sub-page, you can assign 
one or more parameters to each Smart 
knob, MIDI CC, and Key switch. In the 
Name column on the left the source 
controls are lined up. The destinations and 
their assignment settings are shown in the 
Parameter section on the right. There are 
three tabs for accessing the sub-pages of 
different source control types: Smart 
knobs, MIDI CCs, and Key switches. 
 
 
 
 
SMART (Smart knob assignments): Shows all Smart knob assignments of the patch. You can 
create, edit, and delete assignments in this section. Select a source Smart knob in the Name 
column on the left to show its destinations in the column on the right. 

MIDI (MIDI CC): Shows all MIDI CC assignments of the patch. You can create, edit, and delete 
assignments in this section. Select a source MIDI CC number in the Name column on the left to 
show its destinations in the column on the right. 

KEY SW (Key Switches): Shows all Key switch assignments in the patch. You can create, 
edit, and delete assignments in this section. Select a source Key switch in the Name column on 
the left to show its destinations in the column on the right. See the Key Switches section forfor 
more information on working with Key switches. 
 

Control Line 
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Using the Control Line 
 
The Control line adjusts the behavior and settings of 
control assignments of Smart knobs, MIDI CCs, and 
Key switches. The control line appears on the 
Control sub-page and in the context menus of 
assigned controls. 
 
Name field: Shows the name of the assigned parameter. 

On/Off: Enables or disables the assignment. 

Direction: Adjusts the direction of the controller. Activate this control to invert incoming values. 

Mode Selector: Selects an operational mode for the assignment: Absolute, Switch, or Relative. 

• Absolute sets the destination parameter to a value between the specified minimum 
and maximum. 

• Switch sets the destination parameter to the specified minimum (if source value is < 
64) or maximum (if source value is > 63). 

• Relative adds an offset to the destination parameter without loosing the currently set 
knob position. The minimum and maximum in this mode have a range from –100% to 
+100%. This mode is useful if you want two controls to both affect the same 
destination parameter. 

Range: Sets the minimum (Switch = off) and maximum (Switch = on) values of the assigned 
destination parameter will be set to. 

Mode 
Selector 

Range 
Controls 

Name 
Field 

On/Off Direction 
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To create a new assignment: 

• Click in the Parameter section and 
select a destination parameter from 
the pop-up menu. 

• Right-click (Windows or Mac) or 
Control-click (Mac) a control and 
choose an assignment. 

 
 
 
To delete an assignment, click into the Name field and select Delete Assignment. 
 
To delete all assignments, click into the Parameter section and select Delete All 
Assignments from the pop-up menu. 
 
To access a control's assignments: 

1. Right-click (Windows or Mac) or 
Control-click (Mac) the control. 

2. Go to the Assigned to pop-up menu. 
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Mod (Modulation) Sub-Page 
 
On the Modulation Sub-page there are 
two LFOs (low frequency oscillators) 
which can be used to modulate Structure 
parameters per patch. The modulation 
amount of LFO 1 can be controlled by the 
Mod wheel (MIDI CC 1). The modulation 
amount of LFO 2 can be controlled by 
Aftertouch.  
 
LFO On: Activates the LFO. The LED is 
lit yellow when activated. 

Rate: Adjusts the speed of the LFO in Hz. 

Step: Switches the LFO to a stepped waveform, rather than a smooth line between each point. 

Grid X: Activates a horizontal tempo grid for editing the LFO waveform. 

Grid Y: Activates a vertical amplitude grid for editing the LFO waveform. 

Key Trig (Key Trigger): Selects a restart condition for the LFO, or OFF for free-running. 1st 
Note restarts the waveform when the first note of a chord is played. Note restarts the LFO each 
time a key is pressed. 

Sync: Synchronizes the LFO speed to the session tempo. 

Delay: Adjusts a delay time after pressing a note before the modulation starts. 

Fade: Adjusts the time taken for the modulation to fade in. 

Random Start: Sets a random start phase for the LFO waveform. 

Random Rate: Adjusts the amount of random LFO rate variation. 

Random Depth: Adjusts the amount of random LFO amplitude variation (e.g. for Sample & 
Hold waveforms). 
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Source: Fades the modulation source between LFO only (left), LFO scaled by Mod wheel 
(center), and Mod wheel only (right). 

Destination: Selects a destination parameter to be modulated: Pitch, Filter cutoff, Filter 
resonance, Amp level, Stereo position (Pan). 

Depth: Adjusts the intensity of the applied modulation. 
 
Output Sub-Page 
 
On the Output Sub-page you can assign the 
patch an individual outputs, and adjust its 
output level and send amount to each of the 
four Send Effect slots on the Effects page. 
 
FX Send On: Activates the Effect Send for 
the patch. 

FX Send Level: Adjusts the level sent from 
the patch to the Effect Send. 

Pre: Sets the Effect Send to pre-fader 
routing. When activated the Send level is only 
controlled by the Send fader, not the patch 
level or output level faders. 

Level Trim: Adjusts the patch's output level.  

Output Bus: Selects an individual Output bus for the patch. 

Enable Part Sends: Activates effect sends from within parts in the patch. 

Enable Part Outputs: Activates individual outputs for parts in the patch. 
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Sampler Part Parameter Sub-Pages 
 
To access the sub-pages for Sampler parts: 

1. Select a Sampler part in the Part list. 

2. Click the sub-page tabs in the Parameter panel. 
 
Part Sub-Page 
 
Octave: Transposes the incoming MIDI 
notes for the patch in octave steps. 

Semi: Transposes the incoming MIDI 
notes for the patch in semitone steps. 

Fine Tune: tunes the patch up and 
down in cents. 

Receive Pitch Bend: Activates the 
reception of MIDI Pitch Bend for the 
part. 

Pitch Key Track: Adjusts the depth of 
transposition of the sample over the 
keyboard. 

Mono: Limits the part to monophonic playback. 

Legato: Activates Legato mode. If Mono mode is on, samples are not retriggered from the start 
when playing overlapping notes. 

Mono Mode: Selects which note is played when several keys are held in monophonic playback 
mode. 

Glide: Selects a glide mode. Off disables pitch glide. Legato glides only between legato played 
notes. On glides all the time. 
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Glide Time: Sets the time needed to glide from one note to the other. 

Max Polyphony: Sets the maximum number of voices available for the part. 

Note: Each sample zone in each Sampler part triggered by a note-on uses one voice. For 
example, a patch containing two Sampler parts with one zone each per key will use two 
voices for each held note. 

Key Polyphony: Adjusts the maximum number of voices that each key can play. Default value 
is Any which means unlimited. Priority Sets the voice stealing priority. Voices in parts set to low 
priority will be stolen first. 

Sample Start Point: Changes the attack sound of zones by moving their sample start points 
later. 

Key Range: Sets the key range in which the part plays. You can define the upper and lower 
borders and a transition. 

Vel Range (Velocity Range): Sets the velocity range in which the part plays. You can define 
the upper and lower velocity limits and a transition. 
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Filter Sub-Page 
 
Tip: For detailed information about the Envelope (AHDSR) controls, see the Envelope 
Controls section. 
 
Filter Type: Selects a filter type. 

Cutoff: Adjusts the filter cutoff 
frequency. 

Envelope On: Activates enveloping of 
the cutoff frequency. 

Envelope Inv (Inversion): Inverts the 
polarity of the filter envelope. 

Envelope Level: Adjusts how strongly 
the filter envelope modulates filter 
cutoff. 

Keytrack: Adjusts the cutoff 
frequency across the keyboard. 

Vel (Velocity): Adjusts how strongly the incoming velocity affects filter cutoff. 

Attack: Sets the time it takes for the filter envelope to reach its maximum value. 

Hold: Adjusts the length of the Filter envelope Hold time. 

Decay: Sets the time the Filter envelope takes to fall from hold level to sustain level. 

Sustain: Adjusts the level of the Sustain segment. The Filter remains at this level as long as 
the note is held. 

Release: Sets the time it takes for the Filter envelope Release segment to fall to zero when the 
note is released. Use shorter times for an immediate closing of the filter. Longer times cause 
the filter cutoff to decay slowly. 
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Sync: Scales the envelope times with the session tempo. 

Envelope Velocity Curve Selector: Sets the curve 
for translating incoming velocity values to envelope 
level (Inverse, Linear, Normal, Squared, Cubed, 
dB, Zone). 

Vel Sens (Velocity Sensitivity): Adjusts the 
envelope velocity sensitivity (range in dB between 
lowest and highest velocity). 

Env Key (Envelope Key Scaling): Scales Envelope 
Attack, Hold and Decay times across the keyboard 
(positive values make high notes faster). 

Rel Key (Release Key Scale): Scales the Envelope 
Release time across the keyboard (positive values 
make high notes decay faster). 

Input Velocity

Inverse

Linear

dB

Output Level

Vel
Sens
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Amp Sub-Page 
 
Tip: For detailed information about the Envelope (AHDSR) controls, see the Envelope 
Controls section. 
 
Level: Adjusts the part's amplifier level. 

Pan: Adjusts the part's stereo panorama 
position. 

One Shot Envelope: Activates one shot 
mode, ignoring note-off and skipping the 
envelope sustain phase. In this mode, the 
Decay fader sets a gate time for the note. 

Equal Power Mapping Fades: Activates 
equal power crossfades between sample 
zones. This makes crossfades between 
sample zones slightly louder at the 
midpoint. This, in conjunction with editing 
Velocity and Key Range Fades in the Mapping editor (see Mapping Section), can improve the 
smoothness of crossfades for ensemble sounds. 

Keytrack: Adjusts amplifier keytracking. At zero the amp level is the same for all keys. Positive 
values make the level increase as you play up the keyboard. 

Voice Fade: Adjusts an alternative fast release time, used when a note is cut off by an 
Exclusive Group setting, Polyphony limit, or mono mode. 

Attack: Softens the Attack phase of Instruments by applying an amplitude envelope to the start 
of each Instrument hit. Move the control to the right to increase the time it takes for the attack to 
rise to full amplitude. 

Hold: Adjusts the length of the Amp envelope's Hold time at the end of the attack phase. 

Decay: Shortens the played instrument hits by applying an amplitude Decay after the Hold 
time. 
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Sustain: Adjusts the level of the Sustain segment. The signal remains at this level as long as 
the note is held. 

Release: Sets the time it takes for the Release segment to fall to zero when the note is 
released. Use shorter times for an immediate stop of the sound. Longer times cause the sound 
to fade out gradually. 

Sync: Scales the envelope times with the session tempo. 

Envelope Velocity Curve Selector: Sets the 
curve for translating incoming velocity values to 
envelope level (Inverse, Linear, Normal, 
Squared, Cubed, dB, Zone). 

Vel Sens (Velocity Sensitivity): Adjusts the 
envelope velocity sensitivity (range in dB between 
lowest and highest velocity). 

Env Key (Envelope Key Scaling): Scales 
Envelope Attack, Hold and Decay times across the 
keyboard (positive values make high notes faster). 

Rel Key (Release Key Scale): Scales Envelope 
Release time across the keyboard (positive values 
make high notes decay faster). 
 

Input Velocity

Inverse

Linear

dB

Output Level

Vel
Sens
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Mod (Modulation) Sub-Page 
 

 
 
Matrix (Modulation Matrix) 
 
Ignore MIDI Performance Controls: Selects whether the Sampler Part Always ignores MIDI 
performance controls, ignores MIDI performance controls only after notes have been released 
(Release), or does not ignore MIDI performance controls (Off). 

Source: Selects a modulation source. 

Modifier: Selects an optional modifier to apply to the source value. 

Modifier Depth: Adjusts how strongly the modifier applies to the source. 

Destination: Selects a destination parameter to be modulated by the source. 

Depth: Adjusts the general modulation depth. 
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LFO 3/LFO 4 
 
The two LFOs (low frequency oscillators) can be used to modulate Structure parameters per 
part.  
 
LFO On: Turns the LFO on and off. The LED is lit yellow when activated. 

Rate: Adjusts the speed of the LFO in Hz. 

Step: Switches to a stepped waveform, rather than a smooth line between points. 

Grid X: Activates a horizontal tempo grid for editing the LFO waveform. 

Grid Y: Activates a vertical amplitude grid for editing the LFO waveform. 

Key Trig (Key Trigger): Selects a restart condition for the LFO, or OFF for free-running. 1st 
Note restarts the waveform when the first note of a chord is played. Note restarts the LFO each 
time a key is pressed. 

Sync: Synchronizes the LFO speed to the session tempo. 

Delay: Adjusts a delay time after pressing a note before the modulation starts. 

Fade: Adjusts the time taken for the modulation to fade in. 

Random Start: Sets a random start phase for the LFO waveform. 

Random Rate: Adjusts the amount of random LFO rate variation. 

Random Depth: Adjusts the amount of random LFO amplitude variation (e.g. for Sample & 
Hold waveforms). 

Source: Fades the modulation source between LFO only (left), LFO scaled by Mod wheel 
(center), and Mod wheel only (right). 

Destination: Selects a destination parameter to be modulated. 

Depth: Adjusts the intensity of the applied modulation. 
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Output Sub-Page 
 
On the Output Sub-page, you can assign the part to individual outputs, and adjust its output 
level and send amount to each of the four Effect slots on the Effects page. 
 
FX Send On: Activates the Effect Send for the part. 

FX Send Level: Adjusts the level sent from the part to the Effect Send. 

Pre: Sets the Effect Send to pre-fader routing. When activated the Send level is only controlled 
by the Send fader, not the patch level or output level faders. 

Level Trim: Adjusts the part's output level.  

Output Bus: Selects an individual Output bus for the part. 

Preload Buffer: Adjusts the amount of sample data that is preloaded into RAM. This parameter 
depends on the Pro Tools Plug-In Streaming Buffer setting under Setup > Playback Engine. 
Higher settings for both parameters allow for more sample data to be preloaded. This can be 
useful when using extreme transposition, or when modulating the sample start point, but should 
be set to lower values to minimize RAM usage. Set this value to maximum to load samples 
completely into RAM. 
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Envelope Controls 
 
Both the Filter Sub-page and the Amp Sub-page 
provide common controls for an Envelope 
generator. The Envelope can control how the Filter 
or Amplitude evolves over time (from MIDI note on 
to MIDI note off). You can adjust the parameters of 
the Envelope using the Envelope graph, Fader 
controls (in Fader view), or text fields (in Text view). 
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Envelope Graph 
 
 
 
 

 
 
The Envelope graph provides a visual representation of the envelope and it also lets you edit 
the Time, Curve, and Level parameters of different stages of the Envelope. 
 
To adjust the Level (in dB) of the Initial Level, Attack, Hold, or Sustain portions of the 
Envelope, do one of the following: 

• Click the corresponding solid-white control point, and move it up or down. 

• In Fader view (Sustain only), drag the corresponding Level fader up or down. 

• In Text view, enter a Level value. 
 
To adjust the Time of the Attack, Hold, Decay, or Release portions of the Envelope, do 
one of the following: 

• Click the corresponding solid-white control point, and move it left or right. 

• In Fader view, drag the corresponding Time fader up or down. 

• In Text view, enter a Time value.  

Initial Level 
Control Point 

Level and Time 
Control Point 

Decay Time and 
Sustain Level 
Control Point Sustain Level (only) 

Control Point

Release Time 
(only)  
Control Point 

Curve 
Control Point 
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To adjust the Curve of the Attack, Hold, Decay, or Release portions of the Envelope, do 
one of the following: 

• Click the corresponding hollow-white control point, and move it up or down. 

• In Text view, enter a Curve value. 
 
 
To adjust the Velocity Sensitivity of the Attack, Hold, Decay, Sustain, or Release portions 
of the Envelope, do one of the following: 

• In Fader view, drag the corresponding Velocity Offset fader up or down. 

• In Text view, enter a Velocity Sensitivity (Vel) value (–100% to +100%). 
 
 
Fader View Controls 
 

 
 
In Fader view, you can use Faders to adjust the Time (AHDR), Level (S), and Velocity Offset 
values. You can also double-click the Velocity control to invert it. 
 
To select Fader view, from the View menu, select Fader. 

Velocity Sensitivity 
(inverted) 

Level (S only) 

Velocity Sensitivity; 
Time (AHDR only) 



 

 80  
 

 
Text View Controls 
 
In Text view, you can enter values for all of the variable 
parameters of the envelope. 
 
To select Text view, from the View menu, select Text. 
 
Time: Adjusts the Time of the Attack, Hold, Decay, or Release segments of the envelope (from 
0 ms to 100 seconds). 

Vel: Adjusts the Velocity Sensitivity of the Attack, Hold, Decay, Sustain, or Release segments 
of the envelope (from –100% to +100%). 

Curve: Adjusts the slope of the Attack, Hold, Decay, or Release segments of the envelope 
(from –100 to +100). 

Level: Adjusts the Level of the Attack, Hold, or Sustain segments of the envelope (from –INF 
dB to 0.0 dB). 

Sync: Scales the envelope times with the session tempo. 

Init Level: Adjusts the initial level (from –INF dB to 0.0 dB) at MIDI Note On before the onset of 
the Attack segment of the envelope. 

Envelope Velocity Curve Selector: Curve for 
translating incoming velocity values to envelope level 
(Inverse, Linear, Normal, Squared, Cubed, dB, Zone). 

Vel Sens (Velocity Sensitivity): Adjusts the envelope 
velocity sensitivity (range in dB between lowest and 
highest velocity). 

Env Key (Envelope Key Scaling): Scales Envelope 
Attack, Hold and Decay times across the keyboard 
(positive values make high notes faster).  

Rel Key (Release Key Scale): Scales Envelope Release 
time across the keyboard (positive values make high 
notes decay faster). Input Velocity

Inverse

Linear

dB

Output Level

Vel
Sens
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Effects Page 
 
The Effects page provides four global Send Effect slots (Send 1–4) and the Main output, each 
of which provides four effects Inserts. Signals from each patch, part, or zone can be sent 
individually to the Send Effect slots using its Output sub-page. 
 

 
 

The Effects page in the Parameter panel is divided into two sub-pages: 
 
Global Send Effects and Main Output Page: Provides five effects send slots. Each slot can 
hold 4 inserts, which allows for complex multi-effects processing The outputs of the slots are by 
default sent to Structure's Main output, but they can also be routed to individual outputs. An 
effect slot provides the following controls: 

• Insert 1–4 

• Output selector 

• Level control 

• On/Off switch 

Effect Parameter Page: Provides controls for editing the selected effect algorithm. To access 
the Effect parameter page, click the Effect insert button. 

Send Effect 
Slots 

Page Tabs 

Main Output 

Output Selector 

Insert Selector 

Effect Insert 
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Send 1–4 
 
Insert Selector: Selects an insert effect. 

Output Selector: Selects an individual Output bus for the Send Effect slot. 

Level: Adjusts the Send Effect slot's output volume. 

Send On/Off: Activates or deactivates the Insert effects. 
 
Out 1 (Main Output) 
 
Insert Selector: Selects an insert effect. 

Level: Adjusts Structure's output volume. 

Send On/Off: Activates or deactivates the Main output's Insert effects. When activated the LED 
is lit. 
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Assigning Individual Channel Outputs 
 
You can assign Send 1–4 and Out 1 to individual outputs. These can be 
used as inputs for Auxiliary Input tracks for further mixing and processing. 
 
To assign an individual output: 

1. Select an output for the channel from the Output pop-up menu. 

2. Create an Auxiliary Input track in your software session. 

3. Select the Structure output as an input for the Auxiliary Input Track. 
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Editing Effects 
 
To insert an effect, click the Insert selector and 
select an effect from the pop-up menu. 
 
To bring up the Parameter page of an effect, 
click the effect insert. 
 
To return to the Effect slots, click the Back button 
on the Parameter page. 
 
To remove an effect, click the Insert selector and 
choose No Effect from the pop-up menu. 
 
To send a patch, part, or zone signal to a global 
Send Effect slot, on the Output sub-page, activate 
the corresponding FX Send and adjust the Level 
fader. 
 
To bypass an Effect insert, control-click the Effect 
insert. A bypassed Effect insert appears greyed out. 
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Database Page 
 

 
 

The Database provides tools for key word based searching of patches, parts and samples 
(audio files) on the local file system. Files can be registered to the database and metadata 
tagged with information like manufacturer or category. Three columns of selectable metadata 
tags enable you to find the files you need. Files on your computer matching the requirements 
are instantly displayed in the Result list and can be loaded directly by dragging them into the 
Patch or Part list. 
 
To display only certain file types in the database, click a file 
type button (one or more) in the menu so that it is highlighted. 
 
To find all files that contain a certain text string in their name or metadata, type the words 
you are searching for into the Search field and press Enter, or click the Looking Glass button. 
The Result list displays all matching files. 
 
To load a patch, part, or sample from the result list, drag the file from the Result list to the 
Patch or Part list. 

View Filter 
Controls 

Database 
Management 

Menu 

Search 
Field 

Metadata 
Search 
Columns 

Result List 
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View Filter Controls 
 
Patch: Activates the displaying of only patches. 

Parts: Activates the displaying of only parts. 

Sample: Activates the displaying of only samples. 

All: Activates the displaying of all file types. 
 
Database Management Menu Commands 
 
Scan Directory: Opens a dialog that lets you choose a directory to scan. Select the directory 
you want to scan and click Choose to scan the directory for Patches, Parts, and Samples. Any 
Patches, Parts, or Samples that are found will be added to the Database. 

Open Metadata Editor: Brings up a dialog to edit 
the selected file's metadata tags. Any changes to 
the metadata are saved to the original patch file 
when you click OK. 

Unregister from Database: Removes the 
selected entry from the Database. 

Remove Missing Files: Removes all entries from 
the Database that reference missing files (files that 
have be deleted or moved). 

Get Metadata from Registered Files: Refreshes 
the database entries of all selected files. This is 
useful to update the database information for 
patches, parts, or samples that have been 
previously tagged by other users. 



 

 87  
 

 
Rebuild Database: Clears all entries from the database, rescans all directories that have been 
registered with Structure (using the Edit Content Locations command), and rebuilds the 
Database. This may take awhile! 

Important: The Rebuild Database command will clear the metadata for all files that are 
not Structure format patches or parts, and also all Structure format Patches and Parts that 
are located in folders not listed under Edit Content Locations. 

Edit Content Locations: Opens the Content Locations dialog where you can see which 
directories are registered with Structure. You can edit, add, and remove the directory paths 
used for locating Structure Content. 
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Browser Page 
 

 
 
The Browser lets you search and display the local file system. Files like patches, parts, and 
samples can comfortably be loaded from here using drag and drop. The Browser is not 
supposed to be a file manager. Modifying operations like copying, moving, or deleting are not 
available. 
 
To display only certain file types in the browser, click a file 
type button (one or more) in the menu so that it is highlighted.  

Page Tabs 

Browser 
Controls 
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Common Operations in the Browser 
 
The following are common tasks using the Browser: 

• Drag a patch into the Patch list to load it. 

• Drag a patch onto another in the Patch list to replace it at the same position using the 
previous settings for MIDI input, Individual output, and Automation channel. 

• Drag a part into a Part list to load it. 

• Drag an audio file onto a Patch module or into a Part list to load it. If no sampler part is 
selected, a new one is created at the end of the Part list. If no patch is selected, a new 
patch with a sampler part is created.  

 
Previewing Samples 
 
In the browser and all file dialogs, you can preview all types of supported audio files. 
 
To preview samples before loading, click the speaker icon 
in the left browser column. Click again to stop playback. 
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Browser Controls 
 
 
 

 

 
 
 

 
 
Patch: Activates the displaying of only patches. 

Parts: Activates the displaying of only parts. 

Sample: Activates the displaying of only samples. 

Show All: Activates the displaying of all file types. 

Previous Directory: Navigates to the previous folder. 

Next Directory: Navigates to the next folder. 

Directory Up: Navigates one folder level up. 

Show Favorites: Shows your Favorite folders. 

Add to Favorites: Adds the selected folder to your Favorite folders (accessible through the up 
and down arrows in the patch module). 

New Folder: Creates a new folder. 

Delete: Deletes the selected file or folder. 

Folder History: Shows the 20 last selected folders. 

Previous 
Directory 
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Directory 

Directory 
Up 

Refresh 
View 
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Setup Page 
 
The Setup page contains controls for adjusting 
Structure's basic configuration and behavior. 
There are settings for improving system 
performance and software integration. There are 
four sub-pages giving access to settings for 
different purposes: 
 
 
 
 
Global: Shows global settings and preferences. For example, 
for activating/deactivating these tool tips. 

Engine: Shows disk streaming and performance settings. 

Instrument: Shows instrument-related settings. 

Content: Shows settings for importing and handling audio files. 
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Global Settings 
 

 
 

MIDI Note Display 
 
The MIDI Note Display selector defines how incoming MIDI note values are interpreted by 
Structure and displayed in the Keyboard section. 

• Middle C = C3 
• Middle C = C4 
• Middle C = 60 (MIDI note number) 

 
Interface Options 
 
Auto Open Part List: Expands the part list of the selected patch automatically. 

Show Tooltips: Activates or deactivates the displaying of tool tips. A tool tip is a small window 
that displays descriptive text for a specific control. It appears next to the cursor when holding 
the cursor over a control for longer than one second. 

Structure Editor; Takes Keyboard Focus Enables keyboard focus for key commands in the 
Editor window. Works only for key commands not using combinations with the Alt and Control 
keys (Windows), or the Option and Command keys (Mac). 
 
For more information on key commands, see the Structure Key Commands section. 
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Pro Tools Integration 
 
Disk Prioritization: Adjusts between reliable playback of audio tracks and Structure voices, or 
playback of a potentially higher number of Structure voices. When audio tracks and samples 
are stored on separate disks, or when the software will play back many audio tracks it is 
recommended to set this value towards Audio Tracks to enable direct Structure integration with 
the software audio engine (disk scheduler). When fewer audio tracks are playing back in 
parallel with Structure, set the parameter towards Sampler Voices for a higher polyphony and 
more voices. 
 
Important: 

• Structure must be newly instantiated (loaded) for Disk Prioritization changes to take effect. 

• The Disk Prioritization feature works only with Pro Tools 7.3 or higher. 
 
Smart Knob Default CC Number 
 
MIDI Controller Number: Selects the default MIDI controller number assigned to each Smart 
knob when a new patch is loaded. 
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Engine Settings 
 

 
 

Disk Streaming 
 
Use Streaming: Activates or deactivates disk streaming. When activated, Structure reads 
samples that do not fit into RAM from your computer's disk. When deactivated, all samples are 
loaded fully into RAM. 

Maximum Buffer Size: Adjusts the maximum RAM used for audio disk streaming buffers in 
MB. Increase this value if audio drop-outs are occurring or if Structure is streaming samples 
from multiple disks. 

Maximum Pre-Load Memory: Adjusts the maximum amount of RAM Structure will use to 
preload sample data in MB. Reduce this value if high RAM usage in Structure conflicts with 
other applications. Increase the value if you are unable to load patches due to insufficient RAM. 
 
Performance 
 
Resampling Standard: Selects standard quality conversion when transposing samples to 
minimize CPU usage. 

Resampling High Quality: Selects high quality conversion when transposing samples, using 
more CPU performance per voice. 
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Instrument Settings 
 

 
 
General 
 
Transpose: Transposes all patches in semitone steps. 

Fine Tune: Fine tunes all patches in cents. 
 
Performance 
 
Max Polyphony: Adjusts the maximum number of voices that will be played by the whole plug-
in instance. 

Max CPU: Adjusts the limit of Structure's maximal CPU usage. If this limit is exceeded, 
polyphony will temporarily be reduced to lower the CPU usage. 
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Content Settings 
 

 
 
Copy Samples to Local Drive Options 
 
If samples or patches are loaded from volumes like CDs, DVDs, or over a network, Structure 
will load the audio files into RAM by default. This can lead to sample playback performance 
issues because of the slow data transfer between media, or limited RAM. Using the Copy 
Samples to Local Drive command, you can transfer all used audio files to your computer's 
disk. After transferring Structure can load the concerned patches and parts without requiring the 
source CD, DVD, or network folder. See Copy Samples to Local Drive for more information. 

Note: REX files are automatically transferred to disk (into the session folder) when loading from 
external media. 
 
Import to: Selects wether files will be copied to a user-defined folder or to the Pro Tools 
session folder. 

Path: Selects a user defined folder to which the audio files will be copied. 

Clean Up: Deletes all transferred files located in the user-defined folder. 
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Content Search Folders 
 
If patches can not find their samples because directories have been renamed or moved, 
Structure will automatically search for missing samples in the specified Content Search Folders, 
pointing the patches to the new file location.  
 
To point Structure to a new sample location: 

1. In the section Content Search Folders, type in the new path of the Structure Factory 
Libraries folder, or select a folder using the file dialog. 

2. Click Search Now. 
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Editor Window 
 
 
 
 

 
 
 
 
In the Editor window, you can display and modify the samples within the sampler parts of a 
patch. You can wave-edit and loop samples, create and modify sample mappings, and adjust 
individual playback, filter, and amp settings per sample zone. 

Treeview Section Mapping Section 

Edit  
Menu 

Patch  
Name 

Sub-Page  
Tabs 

Edit  
Section 
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Resizing the Editor Window 
 
The whole Editor window and its three areas can be resized: 
 
To resize the Editor window, click the handle in the lower right of the 
window and drag to resize the window. 
 
 
 
 
To resize an Editor section, click the corresponding handle and drag to 
resize the section. 
 
 
 
To leave the Editor, click the Exit button on the top right of the Edit section. 
 
 
 
Samples and Zones 
 
A zone is a loaded sample including all the relevant 
information of keyboard assignment and play parameters 
within Structure. You could see it as a container for one 
sample, and its complete set of parameters for modifying 
that sample, including its loop settings, root key, keyboard 
mapping, and playback parameters. One Zone can consist 
of and play back several separate mono files when you load 
multi-channel samples. If you select a Zone in the Mapping 
section or Treeview, it is automatically selected in all other 
sections of the Editor window. 
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Treeview Section 
 
The Treeview section lists all Sampler parts of the current Patch and the samples contained in 
these Parts. You have to click a part in the treeview to select it for further editing in the Mapping 
and Edit section on the right. 
 
Treeview Controls 
 
Mute Button: Mutes/bypasses the part. 

Solo Button: Solos the part. 
 
Edit Menu 
 
The Edit menu in the Treeview section provides commands for editing and organizing parts and 
zones.  
 
New Folder: Creates a new folder for organizing zones. 

New Part: Creates a new empty part. 

Load: Brings up a file dialog for selecting a part that will be loaded into the patch. 

Save: Brings up a dialog for saving the selected part to disk. 

Replace Samples: Brings up a dialog to locate samples to replace the ones currently selected 
in the part. You would commonly use this function to exchange samples in a part. 

Find Missing Samples: Opens the Find Missing Samples dialog pointing Structure to the 
location of the samples, if a part does not find its samples. See the Finding Missing Samples 
section for more information. 

Import Samples: Opens a dialog to import samples to the part. 

Undo: Undoes the last operation in the Editor page, allowing you to return to a previous editing 
state. 
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Redo: Redoes the last operation in the Editor page, which moves back through the Undo 
history by one step. 

Cut: Cuts the selected parts and zones and copies them to the clipboard. 

Copy: Copies the selected parts and zones to the clipboard. 

Paste: Pastes the selected parts and zones from the clipboard. 

Paste to New Folder: Creates a new folder and pastes the selected parts and zones from the 
clipboard into the new folder. 

Paste to New Part: Creates a new part and pastes the selected parts and zones from the 
clipboard into the part. 

Remove: Removes the selected zone or part. 

Select All: Selects all zones and parts. 

Deselect All: Deselects all zones and parts. 

Invert Selection: Inverts the current selection. 

Expand All: Opens all parts and folders. 

Collapse All: Closes all parts and folders. 

Follow Selection: Links selection of zones in the Treeview, Mapping, and Edit section. 
 
Sort By 
 
The Sort by function sorts the zones in the Treeview according to the following attributes. 
 
Key (Low to High): Sorts the zones by assigned key, starting with the lowest. 

Key (High to Low): Sorts the zones by assigned key, starting with the highest. 

Name (A to Z): Arranges the zones alphabetically. 

Name (Z to A): Arranges the zones in a reverse alphabetical order. 
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Mapping 
 
Use the Mapping functions to arrange (map) the selected samples in the Mapping editor 
according to the following methods. 
 
Root Key Only: Maps the samples according to their root key 

Root Key Centered: Maps samples according to their root key. The key ranges of the resulting 
zones are enlarged equally to the left and right to fill gaps. 

Root Key Up: Maps samples according to their root key. The key ranges of the resulting zones 
are enlarged to the right to fill gaps. 

Root Key Down: Maps samples according to their root key. The key ranges of the resulting 
zones are enlarged to the left to fill eventual gaps. 

Vertical at Root Key: Maps samples according to their root key. Samples sharing the same 
root key are evenly spaced over the full velocity range. 

Chromatic Up: Maps samples chromatically according to the Treeview sorting, starting 
upwards at the highlighted red and regardless of root key. 

Black Keys Up: Maps samples to black keys according to the Treeview sorting, starting 
upwards at the highlighted red key and regardless of their root key. 

White Keys Up: Maps samples to white keys according to the Treeview sorting, starting 
upwards at the highlighted red key and regardless of their root key. 

Vertical: All selected samples will be mapped over the velocity range at the highlighted red 
key, regardless of root key or key range. 
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Root Key 
 
The Root Key command sets the zone root keys according to the following behaviors. 
 
Set Root Key to Zone Center: Sets the root key depending on the zone's center in the 
mapping. 

Set Root Key to Zone Bottom: Sets the root key depending on the zone's left border in the 
mapping. 

Set Root Key to Zone Top: Sets the root key depending on the zone's right border in the 
mapping. 

Move Root Key With Zone: Adjusts the sample's root key depending on the current position in 
the mapping to keep it within the key range when editing the mapping. 
 
Refresh 
 
The Refresh function is commonly used to update changes made to the raw audio files, for 
example, after they have been trimmed, looped, or processed in an external editor. 
 
Loop and Length: Updates the loop and length information for the selected zones from the 
actual audio files. 

Root Key and Tuning: Updates the root key and tuning information for the selected zones 
from the actual audio files. 

All: Updates the loop, length, root key, and tuning information for the selected zones from the 
actual audio files. 
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Copy Samples to Local Drive 
 
If you have loaded samples from removable media like a CD, DVD, or over the network into 
Structure, a yellow exclamation mark symbol indicates the affected patches and parts. Use the 
Copy Samples to Local Drive function to transfer the loaded samples to your computer's hard 
disk. On the Setup page, you can define a folder to which Structure will copy these files. After 
transferring the samples Structure can load the concerned patches and parts without requiring 
the source CD, DVD, or network folder. See Copy Samples to Local Drive Options for more 
information. 
 
Selected Patch copies the samples of the selected patch to disk. 

All Patches copies the samples of all patches to disk. 

Session copies the samples of all patches of all Structure instances in your session to disk. 
 
Common Operations in the Treeview 
 
To load one ore more samples, do one of the following: 

• Drag clips from software tracks or the Clip list into the Treeview. 

• Drag wave files from the Structure Browser or Database into the Treeview. 

• Drag wave files from the Explorer (Windows) or the Finder (Mac) directly into the 
Treeview. 
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Mapping Section 
 

 
 
The Mapping section reflects the keyboard assignment of the selected part's samples as 
rectangular zones on a 2-dimensional field. A zone is a loaded sample including all the relevant 
information of keyboard assignment, and play parameters within Structure. Zones can be 
moved, modified, copied or deleted in the Mapping section. The selection of zones in the 
Mapping section is by default mirrored in the Treeview, Wave, and Zone parameters within the 
Editor window. If you want to learn more about Zones, please see the Samples and Zones 
section. 
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Mapping Section Controls 
 
Zoom Tool: Zooms horizontally and vertically into the Mapping section. 

Zoom to Selection: Automatically zooms into the selected zones. You can also double-click a 
zone to zoom in. 

Zoom to Full: Zooms out to show the full key and velocity range. 

Root Key: Sets the root key for the selected zone. 

Note: The Root Key can be entered by clicking a key on the on-screen keyboard, or by 
playing a key on your MIDI keyboard. 

Detune: Detunes the selected zone in cents. 

Level: Adjusts the volume level of the selected zone. 

Key Min: Sets the lowest key that will trigger the zone. 

Key Max: Selects the highest key that will trigger the zone. 

Note: The Key Min and Key Max values can be entered by clicking a key on the on-screen 
keyboard, or by playing a key on your MIDI keyboard. 

Vel Min: Sets the lowest velocity that will trigger the zone. 

Vel Max: Sets the highest velocity that will trigger the zone. 

Control: Selects an alternative MIDI controller for the selection of velocity layers. Two of the 
options that merit special attention are Velocity+MW and MW at Note-On. When Velocity+MW 
is selected, the position of the Modulation Wheel offsets the incoming velocity up or down. This 
is useful for playing swells, such as with brass or string samples. When MW at Note-On is 
selected, the position of the Modulation Wheel at note on determines which velocity is used. 
This is useful if you want to use the Modulation Wheel to control velocity, but you don't want it 
to affect the sound after the note is played. You can use this option with short samples, such as 
pizzicato strings. 
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Select Zone by Midi: Enables the selection of zones by incoming MIDI notes. 

FX Bypass: Temporarily bypasses all Effect parts and Send effects. All effects are 
automatically switched back on when leaving the Editor window.  

Play Zone Tool: Activates the play-by-click mode. Click and hold a zone in the mapping 
section to hear it. 
 
Tuning Reference 
 
 
 

 
 
 
 

The Tuning reference helps when manually tuning zones by playing back a reference tone that 
is adjustable in Hertz. 
 
Tuning Reference On/Off: Activates or deactivates the reference tone. 

Frequency: Adjusts the reference frequency for the A above middle C. The default value is 440 
Hz. 

Reference Note: Selects the current reference note (MIDI note number). 

Volume: Adjusts the volume of the reference note. 

On/Off Reference Note 

Frequency 

Volume 
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Additional Context Menu Entries in the Mapping Section 
 
Show Key Range Fades: Activates the display of Key range fades for all zones in the Mapping 
section.  

Show Velocity Fades: Activates the display of Velocity range fades for all zones in the 
Mapping section. 

Set Fades From Overlaps: Adjusts the Key Range and Velocity Fades to match the overlap 
between zones for all zones in the selected part. This saves you the trouble of having to 
manually edit Key Range and Velocity Fades after adjusting zone borders. 

Show Sample Names: Activates the display of sample names on each zone in the Mapping 
section. 
 
Common Operations in the Mapping Section 
 
To activate the selection of zones by MIDI input, click the Select by MIDI 
button. 
 
To load one ore more samples into the part, do one of the following: 

• Drag clips from tracks or the Clip list into the Mapping section. 

• Drag wave files from the Structure Browser or Database into the Mapping section. 

• Drag wave files from the Explorer (Windows) or the Finder (Mac) directly into the 
Mapping section. 

 
To move a zone within the Mapping section, click in the zone and drag 
it to a new location. 
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To adjust a zone's border in the Mapping section, click the zone's 
border and drag it to a new location. 
 
 
 
 
 
 
 
 
To adjust a velocity fade for the zone: 
1. In the context menu, make sure that Show Velocity Range Fades 

is enabled. 

2. Drag the Velocity Range Handles. 
 
 
 
 
 
 
To adjust a key range fade for the zone: 

1. In the context menu, make sure that Show Key Range Fades is 
enabled. 

2. Drag the Key Range Handles. 
 
 
 
 
 
To select all vertical zones on one or more keys, Ctrl-drag over the keys. 
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Edit Section 
 
The Edit section consists of four sub-pages. 
 
To access a sub-page, click the corresponding sub-page tab. 
 
Zone (Zone Parameters) 
 
Provides controls for all available playback parameters of a Zone, for example, Transpose, 
Modulation, or Output assignment. 
 
 
PITCH 
 
Pitch Track: Enables transposition of the sample over the keyboard. 

Octave: Transposes the pitch in octave steps. 

Semitone: Transposes the pitch in semitone steps. 

Detune: Adjusts the pitch in cents. 
 
 
PLAY 
 
Sample Delay: Adds a time delay between pressing the key and the note playing. 
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ZONE SEL 
 
Variation Mode: Selects if the zone will play every time, or should alternate with other 
overlapping zones. 

• Select Always to make the zone play every time the corresponding note is played. 

• Select Per-Key R.R. (per key Round Robin) to play alternating zones, like Round 
Robin, but maintain an alternation count independently for each key on the keyboard. 
This can help avoid repeating patterns of alternations where the number of played 
notes in a phrase is the same or a multiple of the number of available alternating 
zones. 

• Select Round Robin to play alternating through the available zones. 

• Select Random to randomly select one overlapping zone to play on each note-on. 

• Select Random Excl. (Random Exclusive) to randomly select one overlapping zone 
to play on each note-on and to not repeat the same zone two times in a row (if there 
are more than two zones). 

• Select Never to keep the zone from playing at all. 

Exclusive Group: Other zones in the same group will be cut off when this zone plays. 
 
 
FILTER 
 
Filter Type: Selects a filter type. 

Filter Cutoff: Adjusts the filter cutoff frequency. 

Filter Resonance: Adjusts the filter resonance amount. 

Inv (Invert Envelope): Inverts the polarity of the filter envelope. 

Envelope Depth: Adjusts how strongly the filter envelope modulates filter cutoff. 

Vel (Velocity Depth): Adjusts how strongly the incoming velocity affects filter cutoff. 
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Key Track Root Key: Selects a note around which the filter keytracking pivots. 

Key Track Depth: Adjusts keytracking of filter cutoff. At zero the filter cutoff is the same for all 
keys. At +100% the cutoff follows the pitch exactly. 

Display Mode Selector: Switches between fader and text view for the envelope settings. 

Attack Time: Adjusts the attack time of the filter envelope. 

Hold Time: Adjusts the hold time of the filter envelope. 

Decay Time: Adjusts the decay time of the filter envelope. 

Sustain Level: Adjusts the sustain level of the filter envelope. 

Release Time: Adjusts the release time of the filter envelope. 

Velocity Curve Selector: Curve for translating incoming 
velocity values to level (Inverse, Linear, Normal, 
Squared, Cubed, dB). 

Vel Sens (Velocity Sensitivity): Adjusts the envelope 
velocity sensitivity (range from quietest to loudest note in 
dB). 

Sync to Tempo: Scales envelope times with the tempo. 

Env Key (Envelope Key Track): Scales Envelope 
Attack, Hold and Decay times across the keyboard 
(positive values make high notes faster). 

Release Key Track: Scales Envelope Release time 
across the keyboard (positive values make high notes decay faster). 

Input Velocity

Inverse

Linear

dB

Output Level

Vel
Sens
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AMPLIFIER 
 
Level: Adjusts the amplifier volume level. 

Pan: Adjusts the zone's position in the stereo panorama. 

One Shot Envelope: Activates one shot mode, ignoring note off MIDI messages and skipping 
the envelope sustain phase. 

Select Display Mode: Switches between fader and text view. 

Attack Time: Adjusts the attack time of the amp envelope. 

Hold Time: Adjusts the hold time of the amp envelope. 

Sustain Level: Adjusts the sustain level of the amp envelope. 

Decay Time: Adjusts the decay time of the amp envelope. 

Release Time: Adjusts the release time of the amp envelope. 

Attack Velocity: Adjusts the attack time offset at minimum velocity 

Hold Velocity: Adjusts the hold time offset at minimum velocity 

Decay Velocity: Adjusts the decay time offset at minimum velocity 

Sustain Velocity: Adjusts the sustain level offset at minimum velocity 

Release Velocity: Adjusts the release time offset at minimum velocity 

Attack Curve: Adjusts the shape of the attack phase. 

Hold Curve: Adjusts the shape of the hold phase. 

Decay Curve: Adjusts the shape of the decay phase. 

Release Curve: Adjusts the shape of the release phase. 

Init Level: Adjusts the starting level when the envelope is triggered. 
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Attack Level: Adjusts the end level of the attack phase. 

Hold Level: Adjusts the end level of the hold phase. 

Vel Sens (Velocity Sensitivity): Adjusts the envelope velocity sensitivity (range from quietest 
to loudest note in dB). 

Envelope Key Track: Scales Envelope Attack, Hold and Decay times across the keyboard 
(positive values make high notes faster). 

Release Key Track: Scales Envelope Release time across the keyboard (positive values make 
high notes decay faster). 

Velocity Curve: Curve for translating incoming velocity 
values to level (Inverse, Linear, Normal, Squared, Cubed, 
dB).  

Sync to Tempo: Scales envelope times with the tempo. 
 
 
 
 
 
FX SENDS 
 
FX Send On: Activates the Effect Send. 

FX Send Level: Adjusts the level sent from the zone to global Effect Send. 

Pre: Sets the Effect send to pre-fader routing. When activated, the Send level is only controlled 
by the Send fader, not the patch level or output level faders. 
 
 
OUTPUT 
 
Output Bus: Selects an individual audio output bus for the zone. 

Output Level: Adjusts the zone output level. 

Input Velocity

Inverse

Linear

dB

Output Level

Vel
Sens
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Wave (Wave Editor) 
 
The Wave editor consists of a graphical waveform display showing the sample waveform of the 
selected zone and a transport and control section above. You can use the Wave editor for the 
wave editing and (crossfade-) looping of samples. 
 
WAVE EDITOR CONTROLS 
 

Zoom to Selection: Zooms into the selection. 

Zoom to Full: Zooms out to show the whole waveform. 

Zoom Lock: Locks the zoom factor. When activated the zoom factor stays the same when 
another sample is selected. 

 

 

Play: Plays back the raw waveform unaffected by effects or patch and part settings. Right-click 
the Play button to toggle loop playback on and off. 

Stop: Stops raw sample playback. 

Play from Cursor Position: When this button is activated, clicking in the waveform display 
plays the sample from mouse position 

Show Channel: Activates displaying of the channel in the waveform display. 

Mute Channel: Mutes channel of multi channel audio files. 

Show Summed Waveform: Shows a summed waveform of all channels in the waveform 
display. 

Raw Out: Adjusts the playback volume when playing back the waveform using the play button 
(raw). 

Stop Play 

Play from 
Cursor Position 

Mute Channel Raw Out 
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WAVE EDITOR LOOP CONTROLS 
 
 
 

 
 

The Loop section of the Wave editor provides tools for the creation and playback of sample 
loops. 
 
Loop: Activates looped playback for the sample and displays loop start and end markers in the 
waveform display. 

Edit XFade (Crossfade): Activates loop crossfading and displays Crossfade handles in the 
waveform display. Adjust the crossfade with the green crossfade handles in the waveform 
display.  

Auto Loop Search: Searches automatically for the next good loop point. 

Fine Search: Moves the loop markers by one sample position (frame). 

Length: Displays the current loop length. 

Quality: Displays the quality of the amplitude match for the current loop points in percent. 

Match Length: Sets the length for auto loop searching. The higher this value, the better the 
loop quality but searches take longer. Only powers of two can be entered here. 

Auto Loop Search Fine Search 
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ADJUSTING CROSSFADES 
 
To adjust a loop's crossfade length, drag the green Crossfade handles. 
 
 
 
 
 
 
 
To adjust the curve between a linear and equal-power crossfade, 
drag the Curve handle. 
 
 
 
 
 
 
 
ADJUSTING VOLUME FADES 
 
To adjust a volume fade for the sample, drag the white Fade handle. 
 
 
 
 
 
 
To adjust the Volume fade curve, drag the Curve handle. 
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ADJUSTING CUTS 
 
To create a cut, make a selection and select Cut from the right-click 
menu. 
 
 
 
 
 
 
 
To adjust the cut length, drag the Arrow handles. 
 
 
 
 
 
 
 
 
To adjust a cut's crossfade length, drag the Crossfade handles. 

Note: Waveform edits are only written when saving samples. The originals of 
the loaded samples will not be affected by edits in the Wave editor. 
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WAVE EDITOR CONTEXT MENU 
 
Right-click (Windows or Mac) or Control-click (Mac) in the waveform to 
access the Wave editor context menu. 
 
 
 
 
 
 
 
 
 
Undo: Undoes the last operation in the Wave editor, allowing you to return to a previous editing 
state. You can perform an unlimited number of undo steps. 

Redo: Redoes the last operation in the Wave editor, moving back through the Undo history by 
one step. 

Cut: Cuts and copies the selection to the clipboard. 

Copy: Copies the selection to the clipboard. 

Paste: Pastes the selection from the clipboard into the waveform. 

Set Sample: Sets the sample start and end points to the current selection. 

Set Loop: Sets the loop start and end points to the current selection. 

Set Sample Start: Sets the sample start point to the current selection. 

Set Sample End: Sets the sample end point to the current selection. 

Restore Cut: Removes the selected cut.  
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Browser 

 

 
 
The Browser window allows for displaying and browsing the local file system. Files like 
Patches, Parts, and samples can be loaded from here using drag and drop. See the Browser 
Page section for more information.  
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Database 

 

 
 

The database allows for quick searching of files like patches, parts, and samples that previously 
have been metadata tagged and registered in the database. For more information, see the 
Database Page section. 
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Structure MIDI Processors 
 
Structure provides the following types of MIDI Processors, which can be added as Parts to 
Patches: Rex Player, Alternation Control, Controller to Note, MIDI Transformer, and 
Tuning Scale. 
 
Rex Player 
 
Rex Player triggers rhythmic playback of 
slices in a loaded REX file. 
 
To add a Rex Player as a new Part, import a 
REX file into Structure. 
 
• Current Variation: Selects one of four 

programmable variations of the loop. 

• Copy: Copies the current variation to the 
clipboard. 

• Paste: Pastes over the current variation 
from the clipboard. 

• Revert: Reverts any changes to the current variation to the last saved version. 

• Randomize: Randomizes the current variation. 

• Latch On/Off: Activates/deactivates Latched playback. When activated, playback 
continues after notes have been released. 

• Retrigger: Restarts loop on each note-on. 

• Host Sync: Enables (or disables) synchronization to the Pro Tools session tempo. 

• Split Mode: Sets a split point on the keyboard that divides looped playback and individual 
slice keys. 

• Speed: Adjusts the playback speed (half time, normal, double time). 
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• Max Length: Limits the loop length to 1, 2, or 4 bars. 

• Keytrack: Adjusts how much the loop is chromatically transposed when played across the 
keyboard. 

• Swing: Adjusts the amount of swing. 

• Swing Mode: Selects which notes swing is applied to. 

• Quantize Depth: Quantizes the loop relatively to the selected Quantize grid. 

• Quantize Grid: Selects the timing grid.  

• Beat: Light on and off to indicates the beat during playback. 
 
Alternation Control 
 
Alternation Control determines the selection 
between multiple Sampler parts or layered zones 
within a Sampler part. 
 
To add an Alternation Control Part to a Patch: 

1. Select a Patch in the Patch list. 

2. Choose Part > Add Part > MIDI > 
Alternation Control. 

 
• First Alternate: Selects which alternation 

plays first. 

• Reset After: Resets to the first alternation after the specified number of steps. 

• Min Time: Notes played within this time will trigger the same alternation. 

• Max Time: Sets the time out for reverting to first alternation. 

• Destination: Alternates between layered zones in a Sampler part, or between whole 
parts. 
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• Reset: Manually resets to the first alternation. Available for assignment to a Key switch or 

MIDI controller. 

• Low Key Range: Sets the low key for Alternation Control. 

• High Key Range: Sets the high key for Alternation Control. 

• Bypass: Bypasses the effect. 
 
Controller To Note 
 
Controller To Note generates note-on and note-off 
messages from incoming MIDI controller values. 
This can be useful for such effects as adding 
pedal noises to a piano patch. 
 
To add a Controller To Note Part to a Patch: 

1. Select a Patch in the Patch list. 

2. Choose Part > Add Part > MIDI > Controller 
To Note. 

 
• Sustain Down: Selects a note to be triggered when the Sustain pedal is pressed. 

• Sustain Up: Selects a note to be triggered when the Sustain pedal is released. 

• Sostenuto Down: Selects a note to be triggered when the Sostenuto pedal is pressed. 

• Sostenuto Up: Selects a note to be triggered when the Sostenuto pedal is released. 

• Soft Pedal Down: Selects a note to be triggered when the Soft pedal is pressed. 

• Soft Pedal Up: Selects a note to be triggered when the Soft pedal is released. 

• User CC: Selects a MIDI CC to be converted to note triggers. 

• User On >63: Note triggered when value of specified MIDI CC increases above 63. 

• User Off <64: Note triggered when value of specified MIDI decreases below 64. 

• User Trigger: Triggers the any user-defined notes. 

• Bypass: Bypasses the effect. 
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MIDI Transformer 
 
MIDI Transformer adjusts a selected type of 
MIDI data, with the option of converting it to a 
different type. 
 
To add a MIDI Transformer Part to a Patch: 

1. Select a Patch in the Patch list. 

2. Choose Part > Add Part > MIDI > MIDI 
Transformer. 

 
 
 
 
• Input: Selects a type of event to transform. 

• Convert: Determines how MIDI events are transformed: 

o Off: The value of the selected Input event type is modified (for example, apply a 
velocity curve). 

o On: The selected input event is converted to the Output event type (for example, 
convert mod wheel to expression). 

o Replace: The selected Output event gets its value replaced by the last Input event 
value (for example, use the mod wheel to set note velocity). 

o Offset: The last input event value is added to the value of the selected output event 
(for example, use the mod wheel to increase note velocity). 

• Output: Selects a event type to output. 

• Random: Adds a random offset to the event value. 

• Smooth: Smooths output values. 

• Bypass: Bypasses the effect. 
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Tuning Scale 
 
Tuning Scale applies a different fine 
tuning to each note in the scale. 
 
To add a Tuning Scale Part to a Patch: 

1. Select a Patch in the Patch list. 

2. Choose Part > Add Part > MIDI > 
Tuning Scale. 

 
 
 
 
 
• Start: Shifts the scale left or right to change the root note. 

• Length: Sets the number of notes in the scale (up to 128 for whole-keyboard scales such 
as stretch tunings) 

• Select Scale: There are two scale memories. At any time, one of these is the active scale 
applied to incoming notes. The scales can be selected automatically depending on if you 
play higher or lower than the previous note (some arabic scales are different when playing 
up or down the keyboard). 

• Mode: Determines whether the Tuning Scale transposes or re-pitches the incoming MIDI 
data: 

o Transpose: If after applying the tuning scale, the resulting pitch is nearer to a 
different MIDI note than the one played, the nearest MIDI note is played. 

o Re-Pitch: This is useful with drum samples, where you have a different drum sound 
on each key and you want the tuning scale to adjust the pitch of each drum, not 
trigger a different drum sample from an adjacent key (MIDI note). 

• Depth: Increases/decreases the detuning depth of the whole scale. 

• Bypass: Bypasses the effect. 
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Structure Key Commands  
 

If you enable the Structure Editor Takes Keyboard Focus function on the Setup page, you 
can use the following key commands in the different sections of the Structure Editor window:  
 

 Command Key(s) 
Treeview Rename F2
Mapping 
Section 

Zoom In X T
Zoom Out X R
Zoom In Y Ctrl+Shift+[
Zoom Out Y Ctrl+Shift+]
Zoom Full F
Zoom Selection S
Toggle Play On Click P
Option-drag (Mac) or 
Alt-drag (Windows) 

Copy zones

Command-click (Mac) or 
Control-click (Windows) 

Select multiple zones

Wave 
Editor 

Play/Stop Space
Cut X
Copy C
Paste V
Unskip U
Toggle Loop Play L
Toggle Loop XFade Edit B
Toggle Play on Click P
Zoom in X T
Zoom Out X R
Zoom In Y Ctrl+Shift+[
Zoom Out Y Ctrl+Shift+]
Zoom Full F
Zoom Selection S

Global Delete Delete
Undo Z
Redo Y
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Support 
 
For technical support, please contact us through the Support page of our website: 
www.airmusictech.com/support. 
 

Trademarks and Licenses 
 
Avid and Pro Tools are trademarks or registered trademarks of Avid Technology, Inc. in the 
U.S. and other countries. 

Mac and OS X are trademarks or service marks of Apple Inc., registered in the U.S. and other 
countries. 

Windows is a registered trademark of Microsoft Corporation in the United States and other 
countries. 
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